
Cool Edit version 1.34
Cool Edit is a full featured wave editor for Windows, and was written by me - David Johnston.    Please 
read on.
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Please see the Technical Notes for information on setting up Cool Edit to take full advantage of your 
system.

Warranty Disclaimer
David Johnston (The Author) makes no warranty of any kind, expressed or implied, including any 
warranties of fitness for a particular purpose.    In no event will the author be liable for any incidental or 
consequential damages arising from the use of, or inability to use, this program.



Cool Features
> Multiple instances (copies of Cool) can be loaded, copied to, and pasted from in any mixture of wave 

formats
> Cool-Edit can synthesize just about any sound using the noise and tone generation functions along 

with the various wave transformation functions
> Very clean sample rate conversion possible with Convert Sample Type.
> Batch run any series of comands on a set of files, save as any file type (great for file type conversion 

of hundreds of files) by using the batch processor.
> Any sample can be used as an "instrument" and set to music, like a dog barking Jingle Bells, or 

Tarzan yelling the national anthem
> Waves of any size can be edited, limited only by hard drive space
> Supports PCM, Microsoft ADPCM and IMA/DVI ADPCM .WAV, Sound Blaster .VOC, raw PCM, SMP, 

ASCII Text, AU, Apple AIFF and more.    See data formats
> Practically any file format can be loaded successfully into Cool by using the raw PCM file type, and 

then Adjusting the sample rate, bit rate, and number of channels, as well as performing Byte Swaps 
to get the byte ordering and interpretation correct.

> Add 1960's sounding flanging and special effects using the Flange function.
> Continuous echo of all or part of a sample with filtering for successive echoes possible with Echo.    

Simulate 3D echoes with the Echo Chamber.
> Speed up or slow down samples without affecting pitch, or raise and lower pitch without affecting 

tempo by using Stretch.
> Supports descriptive information, and bitmaps when saved in .WAV format
> Supports a cue list, and a play list when saved in .WAV format for playing portion of a wave in any 

order, with looping
> Built in CD player when the [MCI] CD Audio driver is loaded, and a valid music CD is in the drive
> Brainwave synchronization function available to create sound files that alter your state of mind
> Record and Playback waves using any Windows compatible sound board, even works with the PC 

Speaker driver
> Spatially locate sound sources to appear as if they are coming from different directions by delaying 

one channel a few microseconds
> Most functions have programmable Presets to save and easily retrieve your favorite effects
> You can feel free to experiment, and easily back up a step if you don't like what you did by using the 

Undo function
> 8-band Quick Filter for quickly adjusting equalization.
> FFT filtering and Spectral View make it easy to filter and analyze audio with high precision.
> Compress/Expand/Limit dynamic range using the Compressor function.    Can also act as a noise 

gate to silence audio between spoken words.
> Skewed waveforms can be centered properly using the DC Bias filter, and waves can be normalized, 

faded in, faded out, or panned by using the Amplify function.
> Frequency analysis at the cursor can be continually be performed on the waveform at the cursor to 

better see exactly what frequencies are present, and where.
> Support for unlimited wave formats by allowing others to write custom file formats that Cool Edit will 

support.    See the File Filter API.
> Support for unlimited effects by allowing others to write custom effects modules that Cool Edit will 

support.    See the Effects Modules API.
> Noise Reduction possible to reduce broad band noise up to 20dB and constant noises (like that 

annoying 60 cycle hum) over 70dB.
> Cool Scripts will remember everything you did to arrive at a certain waveform, or transformation and 

remember it for the future.
> Customizable Toolbar (with a little work) possible by customizing the cool.ini file.
> Assign keyboard keys to play specific parts of your waveform by using the cue list.
> Ring Modulation, or any type of modulation possible via Generate Tones or Paste Special.
> Ultimate Distortion effects possible with the Distortion.
> Generate telephone signals using the DTMF Tone Generator.





File menu
The file menu displays file handling options.

File Menu Options:
New
New Instance
Open
Open As...
Re-Open
Close
Save
Save As
Save Selection
Exit



Answers to common Questions (a.k.a. Troubleshooting)
Q:    I had saved some presets using a previous version of Cool Edit, and now they're gone.    
Where did they go?
A:    They are most likely still in your COOL.INI file, but in creating new versions, sometimes it is 
impossible to keep the parameter orders and such the same for some functions.    Look in your COOL.INI 
file and find your previous presets and print them out or write them down.    Perhaps you can re-enter 
them from looking at the data.    Also, you can try to just copy the entries from the previous function 
section to the new one.    Sections that are 100% compatible are [Channel] from 1.33 and the new 
[Channel Mixer] section; [NewFlanger] from 1.33 and the new [Flanger2] section.    Entries from these can
be copied straight across.    Entries from 1.33's [Filter] section can be copied straight across to the new 
[Filter2] section, but be aware that any filters designed are going to be assumed as if they were done at 
44.1khz.    This means a bandpass filter at 5khz done on a 22khz wave will now be assumed to be a 
10khz filter at ALL samplerates.    The new [Amplify2], [Stretch2], and [Tones2] sections are not 
compatable with the previous 1.33's [Amplify], [Stretch], and [Tones].    Sorry for the inconvenience.

Q:    I had written a script using Cool Edit 1.33, and now it won't run properly. Help!
A:    Sorry about that.    In making modifications and everything more generalized, some incompatibilities 
may have arisin.    When making the conversions, I tried to favor keeping Scripts running properly over 
remembering presets properly.    You can print out the SCP file containing your invalid scripts and then try 
to reconstruct it by recording a new script and following along what you had done previously.

Q:    I cannot load normal wave (*.WAV) files.    Why? 
A:    Do you have the file WAVE.FLT in the same directory as COOL.EXE?    The *.FLT files are required 
for any file loading and saving.    Also, no to programs can be running at the same time called "WAVE".    If
you are running another program whose filename is WAVE.EXE or WAVE.DLL, then rename Cool Edit's 
WAVE.FLT to something different like WV.FLT.

Q:    I get an error message when I try to record.    What's up? 
A:    Check the capabilities of your sound card.    You may be trying to record at a rate not supported by 
your hardware.    Some older boards can play at higher rates than they can record.    You may also be 
trying to record in 16-bit mode for an 8-bit card.    When COOL is started, the playback abilities are 
displayed in the audio format box (but this does not necessarily mean you can record at the same rates).

Q:    I get an error message when I try to play a wave.    How come? 
A:    Your board probably does not support the audio data sample rate, or sample size.    Try checking 
"Play 16-bit files as 8-bit" in the Settings box.    This will convert any 16-bit audio data to 8-bit as the file is 
played.

Q:    I just installed a 16-bit audio card, but my 16-bit sound files still sound awful.    Should I take 
my card back? 
A:    No.    Your card is probably fine.    Check to see that the "Play 16-bit files as 8-bit" box is not checked 
in the Settings dialog.    If it is checked, your files are being converted to 8-bit before being played.    Also 
be sure you are using the right DMA settings.    The lower DMA channels can only support 8-bit audio.    
Please check your sound board manuals for this information.

Q:    Why does it take forever to do things like Filter, and to use Spectral View? 
A:    These functions use the Fast Fourier Transform (FFT) to convert the waveform from temporal data to 
frequency data.    The FFT does "zillions" of floating point operations to accomplish this.    If you do not 
have a co-processor (this includes 486SX users!) then these operations are going to take a very long 
time.    A co-processor will speed these operations up by at least a factor of 10, sometimes 20!

Q:    Why does it take so long to save as ADPCM Wave format? 
A:    ADPCM is a compression scheme, which compresses 16-bit samples to 4-bits while retaining much 
of the quality at higher sample rates.    If the multiple pass option is chosen, which provides the highest 



quality, each block of wave data is compressed seven different ways, and the way which sounds most like
the original signal is then saved.

Q:    I am using Windows NT.    Why doesn't my screen redraw when I make a change?
A:    Normally, COOL is set up to "multitask" when the waveform is being drawn, so as not to lock up the 
PC when drawing large waves.    NT automatically multitasks, which throws things out of sync.    Make 
sure the NT Compatibility option is checked under Settings if you experience screen redraw problems.

Q:    How long did it take you to make this program?
A:    It took me almost a year of programming in the evenings and weekends to produce what you see 
here.    I had actually started writing some of the waveform transformation functions six months prior when
I wrote a DOS only version of Cool, which only worked with Sound Blaster files.    I first ported that 
functionality to Windows, then added on functions and features from there, and eventually ended up with 
this creation.    The brainwave function (Transform->Wave) was written around April to May of 1992, and 
eventually released to ShareWare in July of 1992.    I experimented for several months with different 
sound/relaxation techniques before finding the one which worked extremely well.

Q:    Why are some functions not selectable? 
A:    If you have the unregistered version of Cool, you chose which functions you wanted to use for the 
editing session.    The others will not be selectable until you choose them on the next editing session.    
Also, some functions only work on stereo files, such as Wave and Channel Mixer (which becomes Invert 
for mono waves).

Q:    How can I see my wave size information in samples instead of time? 
A:    Double-clicking on the time (or samples Start and End) window will toggle the display between time 
and samples.    This, and double-clicking on the wave to select all, are the only functions that do not have 
a corresponding menu item or button associated with them.    Other shortcuts are double-clicking on the 
waveform type display to change the waveform interpretation (ie interpret the 44K wave as a 22K wave), 
and double-clicking on the green bar to bring up the viewing samples data entry box.

Q:    Why do my recordings sound choppy? 
A:    You probably have too small of a buffer size in the Settings dialog.    A minimal buffer size is about 4 
seconds.    Using a compressed hard drive on a slow PC could also eat up so many CPU cycles, that 
there isn't time left to do recording.    Either try adjusting the buffer size up or down, or record at a lower 
data rate (ie 8 bits instead of 16, or 32K instead of 44K).    I tried very hard to ensure that recordings 
would sound perfect, without any data loss.    If you have problems, see if other recording software has 
the same problems.    If so, you may have a hardware incompatibility between you sound card and your 
main board, video board, or other installed boards.

Q:    My computer crashed while Cool was running, and now I lost alot of hard drive space.    What 
happened? 
A:    Cool uses temporary files for the editing of waves, and the undo buffer.    Since some of these files 
may have been open (the editing temporary buffer is always open) during the crash, the files were never 
closed properly.    Exit Windows, and type CHKDSK /f C: (use whatever drive letter is missing the space). 
If you get "Convert lost chains to files?" or something like that, answer yes.    The missing data will now be
in the root directory as *.CHK files, which you can then safely delete.

Q:    I keep getting "parity error" messages, and the program keeps crashing.    What's going on? 
A:    Some older style PCs do not handle memory properly, and Cool just makes the problem worse since 
it is very CPU intensive.    The "parity error" message appears when one of the bits that were saved into 
DRAM have changed unexpectedly (indicating bad memory).    Most boards have the first 64K of memory 
on the motherboard, so the problem could be either in your memory arrays, or on the motherboard.

Q:    Cool does something really weird that I didn't expect, and I think it's not working right.    
What's a person to do? 
A:    A person should send me mail explaining the bug they've found, and I will respond by either finding a 



fix in the program, or just letting them know that the program is supposed to do that.



Other Programs I've Written

Keep your eyes out for other programs I've written.    If you can't find them anywhere, I will gladly send 
you a copy for about $5 for the disk and postage.

MindSync for Windows v.1.01
This is just like Cool Edit, except most of the fancy transformation functions have been removed.    The 
Wave function is the centerpiece of the program.    MindSync does not include Scripts either.    In general, 
Cool Edit is a superset of MindSync.    The only other difference is that I am not asking any money for the 
MindSync program.

MindSync for DOS v.1.01
This is the original brainwave synchronization program I wrote for DOS and the Sound Blaster.    It only 
generates brainwave files in 22K stereo 8-bit VOC format.    Brainwave synchronization is the same as the
/i Wave function in Cool Edit.

Kaleidoscope Screen Saver v.2.2
This is a great screen saver for use with Windows.    Lots and lots of options let you customize, or 
completely randomize the kaleidoscopic variations.    It's hard to describe the beauty of the living, flowing 
artwork that is the Kaleidoscope screen saver.    Can also change patterns based on incoming music!    
Revive your old CD collection and actually see your music.

After Dark Screen Savers
I have written three after dark screen savers:    Kaleidoscope (scaled down version of the Windows 
counterpart), Organic (fractal designs that look like cells), and String Arts (colorful designs resembling 
string art -- a popular artform of the 60's and 70's where colored string is strung between nails to make 
beautiful patterns).

RPN Calculator
Reverse Polish Notation calculator (like HP calculators).    This calculator has dozens of great functions, 
including Hex/Binary/Decimal/Octal/n-ary base translations, trig functions, factorial, prime number, 
exponents and logs, and even biorhythms.

Wallpaper Maker
Create colorful wallpaper 'tiles' that look superb when tiled as Windows wallpaper.    Never draws the 
same tile twice.    See patterns in the tiles that are only visible when viewed as a group of tiles.

Classic Collection
Various DOS based graphic programs.    If you're looking for some classic programs that are fun to use 
and watch, these may interest you.    Use your mouse to control birth and death rates in a Game of Life, or
place wagers on which species will win out in a different life simulation.    Steer your way through a warp 
speed starfield simulation.    Experiment with Iteraded Function Systems to grow plants and trees.    
Weave your way through the Mandelbrot set (yes, I know, there are thousands of Mandelbrot generators 
out there now).    Shoot marbles around the screen, and experiment with the effects of gravity.    Generate 
screen mazes.    Draw spiro designs, watch string art designs, or point set fractal art.    Even includes a 
character based 'snow' program.    Not much documentation, but most programs include the '/h' or '/help' 
switch for help.



Package Contents
The following files comprise the complete package for Cool Edit 1.34:

COOL.EXE Main program
COOL.HLP This help file
ADPCM.FLT File filter to read and write Microsoft ADPCM *.WAV files
AIF.FLT File filter for Apple AIFF files
AU.FLT File filter for Next/Sun files
DVI.FLT File filter for DVI/IMA ADPCM *.WAV files
PCM.FLT File filter for raw PCM files
SAM.FLT File filter for 8-bit signed audio
SMP.FLT File filter for SampleVision files
TEXT.FLT File filter for ASCII text sample data
VOC.FLT File filter for standard SB Voice files
VOX.FLT File filter for Dialogic ADPCM 8KHz files
WAVEPCM.FLT File filter for PCM *.WAV files
WAVEAU.FLT File filter for CCITT mu-law and A-law *.WAV files
AMPLIFY.XFM Amplify transform
CHAMBER.XFM Echo Chamber transform
CHANMIX.XFM Channel Mixer transform
COMPRESS.XFM Compressor/Expander transform
DELAY.XFM Delay transform
DISTORT.XFM Distort transform
DTMF.XFM DTMF tones generator
ECHO.XFM Echo transform
ENVELOPE.XFM Envelope transform
EQUALIZE.XFM Quick Filter transform
FILTER.XFM Filter transform
FLANGE.XFM Flange transform
NOISE.XFM Noise generator
NONOISE.XFM Noise reduction transform
NORMAL.XFM Normalize transform
STRETCH.XFM Stretch transform
TONES.XFM Tones generator
WAVESYNC.XFM Brainwave Synchronizer transform
CTL3D.DLL DLL for 3-D looking controls
*.SCP        Various script files



Updates since version 0.5
1.34
Custom effects modules (the *.XFM files).    See Effects Modules API to build your own!
Last used settings for practically every dialog is now remembered between program runs in the [Profile] 
section of COOL.INI.
Repeat Last Comand function by using F2 (with dialog) and F3 (immediate with previous settings).
Added variable quality sample type conversion.
Added a pause button to pause during playing or recording.
Added a fully configurable distortion effect for getting grunge and blown speaker sounds.
Added a three dimensional echo/reverb effect to simulate acoustics in rooms of any size.
Added a Generate DTMF tones function for making telephone signals.
Added a batch processor to the scripts for running a script on multiple files.
Added new file formats for Next/Sun (.AU), Raw 8-bit signed (.SAM), SampleVision (.SMP), ASCII Text 
(.TXT), Dialog ADPCM for voice (.VOX), and A-Law/mu-Law for Waves (.WAV) (see Wave Formats).
Auto-play and file format info features added to File-Open dialogs to play sounds through installed sound 
drivers for preview and view the file format before opening.
Moved file filter options selection to Save As dialog instead of always displaying options when saving.
Single channel editing possible for most functions (that do not change size of waveform).
Improved noise reduction speed for stereo waveforms and added more options.    Also displays a noise 
profile for visual inspection.
Sped up display times in most areas.
Sped up Normalize, Amplify and Envelope on slower machines by integerizing routines.
Added Pause button to progress meter so you can free your system in an emergency without losing your 
edits.
Broke out Normalize and Invert into separate functional units.    Normalize can be used in a script now.
Added decibel scales and logarithmic fades to Amplify.
Modified brainwave synchronizer to have separate high and low settings for intensity and centering.
Generate Tones now has separate initial and final modulation parameters and independently adjustable 
frequency multipliers that can also vary over time.
Improved reliability of Monitor Source.
New settings options for temporary drive.
Play may begin from cursor or from left edge of screen.
Frequency analysis window displays information in stereo with left=Cyan and right=Magenta.
CD Player controls improved, now you can Insert as well as Eject.    Also handles over 10,000 CD titles 
and song lists.    That should be enough for anybody!    Also, the IDs used are compatible with the 
MUSICBOX.INI file, and any CD titles in MUSICBOX.INI will be displayed by Cool Edit.
Added auto zoom button to cue list so double-clicking on cue item opens view to just that cue range, or 
zooms into the cue point.
Zoom In without any selection zooms in at cursor now, and highlight does not go away when zooming in.
Wave files may be up to 1 Gig in size, which should be sufficient for most applications.
Open and Save As can be recorded into a script for creating more complex scripts that use temporary 
files.
Current file size and number of samples updated while recording.
Time accuracy increased to 3 decimal digits, and new Frames format added (use Settings to change 
number of frames per second).
Uses fewer resources per instance, so more instances may be open at once.
Right click extends selection (a shortcut to using shift+left click).
Improved stretch function (preserving tempo or preserving none) by using a better interpolation method.
Added new Fractional Interval Overlap elongation method to stretch (preserving tempo or preserving 
pitch).
Notes are turned off now when you are not listening to a Music preview.
Filtering has been improved/fixed to be more accurate with less distortion.
Fixed bug in finding proper file format of a waveform (that was a tricky one!).
Fixed bug where Cool Edit crashed when loading in NT while a CD was in the drive.



Progress bar updates ETA time more often, at shorter intervals.
File types added to Extensions section so programs like File Manager have Cool Edit associated with all 
formats Cool Edit understands (unless format was otherwise associated with a different program).
Progress meter updates ETA time more often for a more accurate result.
Lots and lots of other little tweaks, enhancements, and elbow grease went into this version as well.

1.33
Fixed bug in Filter Transition from initial to final settings... Final frequencies were off.
Frequency analysis calculates fundamental frequency much more accurately.
Added Compressor function to compress/expand dynamic range.
All graphs have double-clickable points to edit the graphical input point directly.
Clicking on any of the graph points displays the point's values below, instead of just displaying the mouse 
position.
Ring Modulation possible by using "Modulate over Source" checkbox.    Instead of generating sine waves, 
the source is modulated by a the sine wave (or any waveform you choose).
Any type of Modulation possible by using Paste Special's Modulate option.
Noise reduction function added.
Sped up some stereo operations for Filter, Spectral View, and Noise Reduction.
Added smoother 16-bit to 8-bit conversions when copying 16-bit files into an 8-bit waveform.

1.32
Filter has adjustable size (previously used 1024, now smoother filtering can be done by using sizes of 
2048 or 4096).

1.31f
References added to the Brainwave Synchronization help.
Cue list and Play list remember their positions better when cutting and pasting shifts their positions.

1.31c-1.31e
Larger files list display.
FFT filter much smoother now (previously had some high frequency noise when doing extremely narrow 
sharp filters).
Adjustable spatial separation for Generate Noise.
New "smooth" option added to Wave brainwave synchronizer for an alternative "feel" to the sounds.    Also
the "gamma" range (frequencies above 200 Hz) has been noted.
New independent left and right meters for Monitor Source, as well as peak indicators.
Clicking on the Cool window in the waveform area will not move cursor location if Cool Edit is not the 
active application.
New display for stereo waveforms, plus a more precise and consistant display for all waveforms.
Toolbar buttons draw a little quicker now.
Flange and Special EFX have been combined into a new more powerful Flanger, with a Special Efx 
option.

1.31b
Space bar will act as a 'play' button.
Warning issued when loading a file takes up ALL available temporary drive space.
Pasting low sample rate waves into high sample rate waves works properly now.

1.31a
Fixed Stretching to less than 50% for preservation modes.
Fixed displaying of waves more than 15 megs in size.
Sped up music generation by using temporary files for each note.    Long music files can be generated up 
to 10 times faster, or even more!
Added Open As to open waveforms into any format desired.
Added Select Entire Wave to quickly select the entire waveform, even if the view is zoomed in.
The Paste and Paste Special functions now have a progress bar like the rest.



1.31
Added the Scripts feature, which allows Cool to remember everything you do, and will let you replay it.    
One script file can contain many individual scripts.
Wasn't loading from command line properly before.
Fixed memory hog/crashing bug in Generate Tones.
Added customizable Toolbar by modifying cool.ini file.
Added play bar to see what part of the wave is currently being played
Added Autocue button to Play List to play a single play list item at a time.
Trim is now undoable.    Please turn off the Undo feature whenever you are doing really really large 
operations if you want Cool to run faster, since it will not have to save Undo information.
Added Save Selection to save the currently highlighted portion of the wave to disk.
Improved method for stretching while preserving pitch or tempo for cleaner sounding waves called 
Interval Overlap.    See Stretch.
Improved 'time left' reporting when recording.
Increased maximum file size from 248 megs to 536 megs.

1.30b
Yah, I know... There weren't supposed to be any more bugs.    But I found some:
Using FFT functions sometimes crashed (like FFT, Frequency Analysis, Spectral View, or Music).    That 
has been fixed!
Undo paste when Hilight After Paste was not checked didn't work.    It does now.
File filters have been modified to allow any format to be broken up into multiple files.    For example, the 
WAV file format can have several file filters for different compression schemes.
IMA/DVI ADPCM compression filter added to package (dvi.flt), which allows compressing of 16-bit audio 
downto 4, 3, and even 2-bit (with noticeable loss in quality at 2-bit).

1.30a
Found more bugs: fixed Undo for Paste (special/loop/regular), and Undo Delete.
Fixed Re-Open on PCM files (would hang).
Added Undo for Music.
Added presets for Envelope and FIlter.
Added initial/final settings for overtones in Generate Tones.
Revised Music dialog by adding Constant Duration checkbox to replace Adjust Duration.

1.30
Find Frequency is now a graph of the frequency spectrum.
Fixed the remaining known bugs, and completed spec for building custom file filters.

1.29b
Custom file filters (WAV, VOC, PCM, and AIFF currently).    See File Filters API to build your own!

1.29a
Selectable wave devices (handles multiple sound cards).

1.29
Edit Left/Edit Right for cutting, pasting, and copying only one channel of a stereo wave.
Adjust sample rate added.

1.28c
Equalizer changed to Quick Filter, since FFT Filter does true, precise filtering.
Graphs have more flexibility with points.
Cue ranges can be associated with keyboard keys, so waves can be played from the keyboard.

1.28a
Spectral View and FFT filtering added.



1.28
File -> Close added.
Customizable presets added to a variety of wave functions.

1.27
Double-clicking on slider bar allows entry of starting and ending samples.
Pre-compute trig tables added to Settings.
Undo function added.

Versions 1.03 to 1.26
Cool-Edit is sizeable.    You can make your window big or little or whatever.
Wave files may be Dropped into the editor from the File Manager, or other applications supporting Drag 
and Drop.
New Instance added to File Menu
Added automatic conversion of 16-bit audio to 8-bit while playing for boards that do not support 16-bit 
audio.
Fixed a major bug having to do with the progress meter.    You can now go on to do other things while 
Cool works in the background on long operations.
Fixed an annoying bug when working with large files that caused the green slider to work inappropriately.
When opening multiple instances of the same wave, different names are given to each instance.
New and Improved Pink noise source.    (Ideal for use with the Wave function).
Cue list and Play list supported for looping and custom play order.
New Setting for viewing mode of Dots (original) or Lines (dots of sample are connected by lines).
Digital Delay transformation added to easily spatially locate sounds to the left or right, or for special 
effects.
New settings option for Save/Save As interpretation of the diskette icon.
Are You Sure? Dialog box added to Silence button.
New waves can be made at any valid sampling rate, by use of the new Custom option.
DC Bias Filter added to Amplify to adjust waves skewed by a voltage.
CD Player has been added to play CD's for recording.    Song titles may also be entered and restored 
automatically on future playbacks.
Brainwave frequency (Wave) function has adjustable graph for easier input of multiple frequencies over 
time.
Sound Blaster VOC file compatibility was added.    Not FULL capability yet, because it does not support 
loops (it only loads the loop once), and ASCII text.    It does however support Sound Blaster Pro formats 
for 44K-mono and 22K-stereo.    It will also load non-standard sample rates if the VOC file was recorded 
at one.
Echo Equalizer added to Echo function to have each successive echo equalized for truer echo effects, or 
just snazzy special effects.
The Listen option was added to the music dialog so that the notes could be played through your MIDI 
setup as a preview.    You can record from the music played as well (if your board supports recording from 
the on-board synth.)
Envelope option was added to have more control over amplifying waves by using an amplification 
envelope.
A few new tone flavors have been added for making more natural sounding instrument sounds, which can
be used with the Music option.
New options in settings dialog for play/record buffer size, and highlighting after pasting.

Color DIBs can be added to the .WAV file format.
Equalizer settings changed to decibels instead of percentages, making it easier to equalize, since the 
logarithmic scale is more natural.
Monitor Source meter is in much better real time since it now does not depend on the selected buffer size.

Versions 0.5 to 1.02
New algorithm implemented for raising/lowering pitches, and speeding up/slowing down waves.



Preset buttons added to Stretch dialog.
Highlighting is faster for slower video cards.
You can use the Shift+Mouse Button to extend the highlighted selection.
uldb Music option was added to put your favorite samples to music (as if you were playing them on a 
keyboard) using a very easy to use music editor.    Only short riffs are supported right now.
Stretching is cleaner sounding.
The Transpose function has been added to the Stretch option to musically raise or lower pitches of 
selected samples.
A linked list approach has been taken for working with the temporary disk file when editing.    Now Inserts 
and Deletes are almost instantaneous when working with very large files.(Fixed cut/paste bug from 1.01)
The RAW file format was added for saving only the wave data without any headers.
Edit keys Delete (Delete Wave Selection), Ctrl+Insert (Insert), Shift+Insert (Copy) and Shift+Delete 
(Paste) were added.
Toolbar was added for quicker access to functions.
The previous Save menu item was changed to Save As, and a new Save was added to save the wave 
currently being worked on without being asked for the file name.
The Silence    option was added to the Transform menu to quickly silence the selection portion.
Extra RIFF information embedded in the .WAV file is now remembered between saves, and can be edited
using the Info dialog.
MS ADPCM Compression is supported for loading and saving compressed files now.
A slight bug in overlapping was fixed.    Overlap pasting past the end of a wave that used to be longer 
would revive data past the end of file.
The Stretch transformation was added to allow stretching and compressing of waves, adjusting pitches, or
adjusting tempos.
Viewing mode of the Beginning and Ending samples, as well as the time window (which displays how 
long the viewed portion of the sample is, or how long the selection is) can be changed between samples 
and time by double clicking on the display.
Generating silence in 8-bit mode works properly now, centering the silence line at value 128.
You may now associate the COOL.EXE program with .WAV files in the file manager.
Command line loading works.    File will automatically play once loaded if another file is not already 
playing.
 Little Yellow Arrows work on files larger than 30,000,000 samples.
Gliding waves from one frequency to another "overshot" before.    For example, gliding from 12Hz down to
7Hz would actually glide down twice the frequency, (instead of -5Hz, -10Hz) resulting in a glide from 12Hz
down to 2Hz instead.    It's fixed now.
Multiple COOL's can be opened at once (which reduced the executable as well) for working with multiple 
waves at once.    It's very easy to copy and paste between waves, even of different formats.
Also, waveform display is instantaneous once loaded in (for example, restoring a minimized long 
waveform displays instantly instead of recalculating).    This allows such effects as the sound level meter 
running while zooming in and out of a waveform.
Displaying long waveforms now "multitasks" with Windows, so other things can be done while it is 
loading.
The progress meter was fixed slightly to allow multitasking with other applications without crashing 
Windows.
When saving a file, the extension .WAV is assumed if no extension is typed.
8-bit stereo pasting (with Overlap) works properly now (slight bug caused screeching problems).      Also, 
overlap pasting past end of file works properly too.
A "Musical Source" checkbox was added to the brainwave transformation to eliminate clicks heard when 
waving musical files.
A Recording level meter was added.    Source input can be monitored through the Options menu for 
setting recording levels.
Lifting up on button after dragging a selection (and leaving the main window) will now act properly, and 
disengage the selection process
Recording to Sound Blaster Pro works properly.    It no longer gives errors and chops up recording.    In 
fact, using COOL to record does a much nicer job than the recorder program provided with Sound Blaster
(at least mine), and there are no "clicks" or other distractions to contend with.



Using "Large Fonts" on some monitors correctly displays main console, as well as progress meter now.

Thanks go out to:
Curtis Palmer, Darrell Plank, David Norris, Duane Young, Geoffrey Tilga, James Blackwell, Jarrod 
Beckman, Mike Rozak, Neil St. Laurent, Richard Pepin, Ron McCabe, Ronald Mendoza, Stan Eker, Ted 
Tatman, Todd Frye and Will Urban.
Other Cool Fans who made suggestions and found bugs here and there.
All those who downloaded Cools 1.05 to 1.31 for your patience in waiting for this version!    I hope it 
was well worth the wait :-)
Those others who also downloaded Cool 133 for waiting even longer (about 6 months) for a new 
version!

Other Acknowledgements
Cool Edit uses Microsoft Coropration's CTL3D.DLL dialog library, which Microsoft has agreed is a publicly
available library and can be use without restrictions.    Please note that Microsoft does not support this 
program in any way, and are not liable for anything that may happen.

All format types have been reproduced from publicly available documentation.    I make no claims that 
they are in any way correct, and as such, may not be compatible with other interpretations of the same 
format.    It is up to you to first test to see that when saving audio files in a particular format, that the file 
generated is compatible with other systems that read the same format.

What Does the Future Hold?
I plan to keep on upgrading Cool Edit, making it more easy to use and useful to more people.    I have 
some definite plans for the next version and I'm sure you'll like it!    I can't say exactly what will be in the 
next version, but following are some things I plan on doing sometime in the future that really need to be 
done.    If you tell me which one you would prefer to have done next by dropping me a line or letting me 
know by email, I can tabulate all the responses so I can decide which to do first.    Here's some ideas:

Extend the interface to an 8-channel model, with previewing of all 8 tracks in real time before 
doing a mixdown.

Optional labeling for all graphs and waveform displays, plus zoom-in ability.
Noise reducer for clicks, pops, and other such static.
Printing ability to print spectral plots, waveform plots, frequency analysis plots, etc.
Multiband compressor to compress each frequency range along a different compression curve.
Csound style vocoder thing for generating richer sounds from scratch (all graphically of course).
Morphing between two waves and other such nifties.
MDI interface (like Word, Excel, etc.) instead of having multiple instances?
Parametric Equalizer as a perhaps faster alternative to using Filter for not-so-precise operations.
Z-plane stuff.
Looping studio for building seamless loops for samplers.
Use of the Sample Dump Standard for directly loading and saving audio data to samplers.

I have some other goodies I am already planning to put in, but you'll just have to wait - I don't want to give
them away!    But rest assured, you'll like them.



Common Procedures (How To...)
If you are asking "How do I...?" then you should find (some of) the answers here!    (Even though it is a 
terribly small list).

HOW DO I:

Convert cleanly from one sample rate to another
Open a file for editing?
Scroll wave left or right?
Create sound effects?
Mix multiple waves together?
Copy a Mono wave to only one channel of a stereo wave?
Spatially locate a mono sound to the left or right?



Opening Waveform Files
There are a number of ways to get a waveform into Cool-Edit for editing.

- Choose File -> Open and find the wave file from the dialog box.

- Double-click on a waveform file from the File Manager (if you have chosen COOL as you editor of 
choice from the File -> Associate dialog).

- Click on a waveform file, or multiple files, in the File Manager, and drag them into Cool-Edit.

- Copy a waveform from any wave editing program, then choose the Edit -> Paste option, or press 
Shift+Insert while in Cool-Edit.

- Create a new Cool-Edit program item in the Program Manager.    In the Command Line field, enter the
path to the wave file to open after the program executable name.    When this icon is double-clicked, 
Cool-Edit will automatically load the wave file you specified in the command line, and play it.

- Choose File -> New to create a new waveform of the appropriate sample rate.    You may now press 
Record to record a new wave to be edited.



Converting Sample Rates
With version 1.34, the best method for converting sample rates is to use the Convert Sample Type 
function.    This function incorporates the methods outlined below and performs them automatically.

There are various methods for converting sample rates.    One way is to simply copy the waveform you 
wish to convert, open a new instance of Cool, and say New.    Choose the new sample rate, bit rate, and 
so on.    Then Paste.    When Cool Pastes samples of a different rate, it converts by doing a linear 
interpolation of the points inbetween when upsampling (converting to a higher sample rate), and it just 
picks out the samples needed when downsampling.    This method is quick and dirty, which means it is 
fast, but is not the cleanest method, and you will get some artifacts and "ringing" depending on the 
sample.

A slightly cleaner method is to use the Stretch function (stretch To cleanly convert, you must run a filter 
over the sample, and use the Stretch function (in Preserve Neither mode).    If you are downsampling (eg 
22K to 11K), you would compress the wave to the ratio of the destination sample rate over the source 
sample rate (eg 11K / 22K = 0.5 = 50%).    Then you would adjust the sample rate (Edit->Adjust Sample 
Rate) to your new rate, keeping the bit size (8 or 16), and the number of channels the same.    The stretch
function uses a weighted average approach when downsampling, which is cleaner than just pasting the 
sample in.

The best method, for downsampling or upsampling without noticing any difference in quality (in fact, 
upsampled waves sound better than the original at a lower sample rate), you must use the filter, which 
can be very slow.    The rest of this article explains how to use the Filter and Stretch functions to upsample
and downsample.

If you are downsampling (converting from a higher sample rate to a lower one), you must Filter the 
wave first to eliminate any frequencies above the destination rate's Nyquist frequency.    The Nyquist 
frequency is a frequency exactly one half the sample rate.    For example, to convert a 44.1K sample to 
22K, you must filter out all frequencies above 11K.    To do this, choose Filter.    Select 'Passive' as the 
filter type, and make the graph such that all frequencies above one half the destination's sample rate are 
set to 0%, and all frequencies below are set to 100%.    If you are cutting the rate exactly in half, as in our 
example, you may use the pre-defined filter "Low Pass 1/2", which does just this.

Once filtered, use the Stretch function to compress the wave.    The ratio of compression is equal to 100 * 
destination_sample_rate / current_sample_rate.    In our example, this would be 50.    If you were 
downsampling from 44.1K to 11K, this would be 25, or 32K to 22K, this would be about 68.8 (68.745% for 
32075, or 68.906 for 32000).
Finally, choose Edit->Adjust Sample Rate to tell Cool what the new sample rate is.

If you are upsampling (converting from a lower rate to a higher one), you must first use the Stretch 
function.    The ration of expansion is equal to 100 * destination_sample_rate / current_sample_rate.    For 
example, if we are converting from 22K to 44.1K, this would be 200.    The stretching will do a weighted 
averate, which results in a linear interpolation of the samples to generate the "in between" samples.    This
interpolation adds alot of high frequency noise, which can simply be filtered out in the last step.

Change sample rates by choosing Edit->Adjust Sample Rate to tell Cool what the new sample rate is.    
This should be done before filtering, so the filter knows what the current sample rate is.

Choose Filter to filter out all frequencies above the Original wave's Nyquest frequency (or one half the 
original sample rate).    In our example, we would filter out everything above 11K, since that is one half of 
22K, or original sample rate.    All frequencies below 11K should be set to 100%, while all frequencies 
above 11K should be set to 0%.    If you were upsampling from 8K, you would set all frequencies below 4K
to 100% and above 4K to 0%.    The filtering will take the linearly interpolated samples, and smooth out all 
the jagged edges.    The result is a sample that now sounds better than it did at it's original sample rate.



Your sample should now be cleanly converted to the new sample rate, and sound spectacular, with no 
ringing, or noise artifacts.



Mono to Stereo Conversion
Use the Edit->Convert Sample Type function to convert Mono to Stereo.    There are other methods that 
work as well.

You can copy the wave at it's current volume directly to one channel or the other.

- Copy the wave in question to the clipboard by highlighting it and choosing Edit -> Copy.
- Go to the stereo wave in question, and uncheck Edit Left or Edit Right in the Edit menu.    Now 

paste the wave with Edit -> Paste.    The wave will be pasted to the channel that remained checked in
the menu.

or

If you wish to place separate waveforms on each channel of a stereo wave and mix at different volume 
levels, you can use the Edit -> Paste Special option.

- Choose File -> New and create a new stereo wave of the sample rate you wish.
- Open a new instance of the program, and open the mono wave you want to place on the left channel. 

If you want to place a stereo wave, you may wish to use the Channel Mixer to mix both channels at 
50% first.

- Highlight the section you wish to place on the left channel, and choose Edit -> Copy.
- Select the new blank stereo waveform, and choose Edit -> Paste Special.    Make sure Overlap is 

checked, looping is turned off, Lock L/R is turned off, and the left volume is 100% while the right 
volume is at 0%.

- To do the right channel, copy the section as you did for the left.
- Place the cursor at the start of the new waveform, and choose Edit -> Paste Special.    Change the 

volume levels so that the left volume is 0% and the right volume is 100%.



Spatial Location
Spatially locating a mono sound makes the sound appear as if it is coming from the left or the right when 
listened to with stereo headphones, even though the actual volume levels for left and right of the wave are
identical.    What happens is one channel is delayed a few milliseconds.    When a sound reaches one ear 
a few milliseconds before reaching the other ear, the brain interprets the delay as hearing the sound 
coming from the direction of the non-delayed signal.

There are two functions that can do this:    Delay and Wave.    Use Delay to place a sound anywhere from
left to right, and Wave if you wish to have the sound source oscillate between left and right.

- First make sure the signal to be delayed is mono in stereo format.    That is, both left and right 
channels are identical.    With a mono source, copy the wave, create a new stereo wave, and paste.    
With a stereo source, use the channel mixer so that both channels get mixed at 50% for each 
channel.

- Highlight the entire selection you wish to spatially locate.    Choose Transform -> Delay or click the 
stopwatch icon.    Choose a delay of up to 2 ms.    Delaying one channel will make the sound appear 
as if it is coming from the other channel.    You can use the preset for Spatial Left or Spatial Right as 
well.

- If you want the source to move left to right, choose the Transform -> Wave function.    Enter the 
cycles per second (eg 0.1 = left to right and back in 10 seconds) in the initial and final boxes (the 
same value for both boxes).    Choose the center position (in the center, left, or right) using the 
Centering control.    Choose an intensity of about 50 or so, greater intensities mean the sound goes 
further left or right off of center.    Also check the Musical Source box if your sound is not noise related.



Creating Sound Effects
Two types of sound effects can be created using Cool-Edit: Noise based, and Tone based.    To create a 
sound effect, you must first generate some noise or tones to base your effect upon.    The basic method is 
to create a few seconds of tones or noise, then use the transformation functions to manipulate the wave 
and create the desired effect.    With these to sound sources, noise and tone, practically any effect can be 
created.

Noise Effects:
Waterfall, wind, and rain
Thunder, snare drum, cymbals, jet engines
Fantasy sounds such as time tunnel vortex, etc.

Tone Effects:
Siren, pipe organ, piano, and other musical instruments
Space ship sounds, whining, whistles, etc.

- First generate a few seconds of noise or tones using the Generate functions.
- Experiment with the different settings (eg white noise, pink noise, overtones, etc.
- Add some silence to the end of the sample by clicking the cursor at the end of the wave, and 

choosing Generate -> Silence.    This will give some room for transformations that "bleed over" such 
as echo.

- Try effects such as Flanging, Filter, and Quick Filter with noise sources, or Stretch and Echo with 
tone sources.

- Try reversing, or copying and loop pasting portions of the wave.
- The possibilities for sound effects are endless, and is only limited to your imagination!



Function Presets
Many of the functions have presets available for easily recalling your favorite settings.    New presets can 
be added at any time.    All preset information is saved in the file cool.ini, usually in your Windows 
directory.

Double-Clicking on any preset will instantly set all controls in the dialog box to that preset.

Whenever you have settings you would like to keep, you may enter name for your settings, and press the 
Add button.    Be careful though, since there is no rule against you adding two presets with the same 
name.    This can get confusing if the presets are different.

To remove a preset from the list, choose the preset, and press Del.

To modify an existing preset, double-click on the preset name, make your modifications, then press Del 
immediately followed by Add.    This will delete the old preset and add your current settings in under the 
same name.

If all presets are removed, the default presets will automatically be reloaded.

If you are finding that your presets are not being saved the next time you use the function, check to see 
that the cool.ini file is not more than 64K in size.    This should never happen, but it may be possible if you 
have hundreds and hundreds of presets.

If you obtained a new version of Cool Edit, and find that your presets have disappeared or double-clicking
on them brings up something mysterious and not the settings you wanted, then I appologize.    In making 
new versions it is sometimes necessary to change the order of entries in the INI file to make room for new
items, etc.    Just remove all your presets to get the Cool Edit defaults and start from there.    Again, if this 
has happened to you, I'm sorry.



File Filters API
File filters (the *.FLT files you see bundled with Cool Edit) are actually separate DLLs (Dynamic Link 
Libraries) that contain the code necessary to read and write various file formats.    If you are interested in 
writing your own file formats, let me know and I will send you a complete description of the File Filters API
along with a sample file format.    This application and the file filters were written in C (not C++) using 
Microsoft Visual C/C++ 1.5.

If you have written file filters in the past, and you find Cool Edit 1.34 does not recognize them, then you 
must change the valid library number from 1967 to 134 and recompile.



Effects Modules API
Transform and Generate effects modules (the *.XFM files you see bundled with Cool Edit) are actually 
separate DLLs (Dynamic Link Libraries) that contain the code necessary to perform the effect.    If you are 
interested in writing your own effects modules, let me know and I will send you a complete description of 
the Transform and Generate Effects API along with a sample transform module.    This application and the
effects modules were written in C (not C++) using Microsoft Visual C/C++ 1.5.



Undo
If the Undo function is enabled, (see settings), you will be able to back up one step if you make a mistake.
Undo information is automatically saved in a temporary file called ~NDOnnnn in your temporary directory 
before you do anything that will change the waveform being edited.    This could slow down wave 
operations on very large waves.

You will be warned if there is not enough disk space to save the Undo information before continuing any 
wave operation.

Press Alt+Backpsace to quickly undo the last operation.



Closing a Waveform
Close will close the wave currently being edited, and show the initial startup information in the status 
boxes.

When a waveform is closed, the associated temporary file is removed, thus freeing up the hard disk 
space that was being used previously.



Scrolling Wave
The green and/or black bar above the waveform indicates which portion of the entire wave is being 
viewed at that moment.    When Zoom In is chosen, the bar gets smaller, since the portion being viewed 
with respect to the entire wave is smaller.

You may click, and drag the green bar at any time to scroll the portion being viewed left or right at any 
time.
clicking in the slider bar region will bring up the Viewing Samples text entry box, to type in starting and 
ending samples.



Mixing Waves
Waves of any sample type can be mixed together into a resultant wave of any sample type.    This means 
you can mix a mono 8-bit 11K wave together with a Stereo 16-bit 22K wave without any problems.

- Create a new instance of the program by choosing File -> New Instance.
- Choose File -> New in the new instance to choose your final sample type.    You may generate a few 

seconds of silence to give yourself a workspace.
- Mix all your waves into the new instance one at a time by highlighting the portion you wish to mix, and

selecting Edit -> Copy.    You may create more new instances and open waves into them if you wish.
- Position the cursor where you wish to place the start of the copied waveform, and choose Edit -> 

Paste Special.    Make sure the Overlap box is checked.    Choose the mixing volume, and press OK.
- Do this for each wave you wish to mix.



Edit menu
The file menu displays all the waveform editing options.

Edit Menu Options:
Undo
Repeat Last Command
Copy
Cut
Paste
Paste Special
Select Entire Wave
Edit Left
Edit Right
Delete Selection
Trim
Viewing Range...
Adjust Sample Rate...
Byte Swap...
Spectral View / Waveform View
Convert Sample Type



Amplify
Channel Mixer
Compressor
Delay
Distort
Echo Chamber
Echo
Envelope
Filter
Flange
Invert
Music
Noise Reduction
Normalize
Quick Filter
Reverse
Stretch
Wave



Transform menu
The Transform menu displays all the waveform transformation options.    Waveform transforms are 
encapsulated in the .XFM files.

Transform Menu Options:
Reverse
Silence
Invert
Music

The following are embodied in XFM files, and may change at any time.    If the function you need is not 
listed, go to the function directly and view it's help information

Quick Filter
Amplify
Echo
Wave
Channel Mixer
Flange
Stretch
Envelope
Delay
Filter
Compressor
Noise Reduction
Distort
Echo Chamber
Normalize



Generate menu
The Generate menu displays all the waveform generation options.    Generate functions are encapsulated 
in .XFM files.

Generate Menu Options:
Generate Silence

The following are embodied in XFM files, and may change at any time.    If the function you need is not 
listed, go to the function directly and view it's help information

Generate Noise
Generate Tones
Generate DTMF Signals



Options menu
The Options menu displays various additional options.

Options Menu Options:
Loop / Play Toggle
Monitor source
Settings...
Info...
Frequency Analysis...
CD Player
Cue List
Play List
Cool Scripts...
Select Wave Device



The View Indicator is the green bar above the waveform being viewed which changes size depending on
the level of Zoom.



The Toolbar is the row of icons just below the menu for quickly accessing commonly used functions.



Quick Help messages appear below the toolbar to give a brief description of the function associated with 
the tool icon.



Cool Edit Quick Reference
Navigating the Main Screen

Keyboard and Mouse Shortcuts

File Functions
Editing Functions
Transformation (Effects) Functions
Audio Generation Functions
Options Menu

Updated features



Navigating Cool Edit
Commonly used functions are represented as icons in the Toolbar.
- Clicking, and holding on any of these icons will bring up a Quick Help message describing the 

function in more detail.

Waveforms are displayed in green. 
- Any portion may be selected by clicking on the waveform, and dragging left or right.
- Holding the SHIFT key while doing so will increase the currently selected portion.
- Double-Clicking on the waveform will select the entire visible wave.

Choose Zoom In to expand the selected portion to full width.    Zoom Out will give a larger view of the 
waveform, while Full View will display the entire waveform in the workspace.

The Play button will play the portion of the wave that is currently being viewed, or the portion that is 
highlighted.
THe Pause button will temporarily pause the playback or recording of audio.    The button turns into a 
Continue button when audio is paused.    If recording, the red record bar turns yellow to indicate a paused
state.
The Record button will start recording at the current insertion point.    Any waveform data after that will be 
recorded over.
Use the Stop button to end waveform playback or recording.

The Record Level Meter below the Play/Record buttons will display red when a waveform is being 
recorded, and a real-time display of the input when Monitor Source is chosen.
The View Indicator depicts which portion of the entire waveform is being viewed in the workspace below.
- Sliding the green bar (when present) left or right scrolls various parts of the waveform below into 

view accordingly.
The Yellow Arrows indicate the point of insertion.    Clicking anywhere in the workspace will move the 

point of insertion to the mouse.

- Double-Clicking on the View Indicator will bring up a Quick View screen to allow direct entry of 
starting and ending samples for the viewing range.

- Double-Clicking on the Record Level Meter will start and stop monitoring.

The Time Display windows show the current Starting and Ending points of the current selection, or 
portion being viewed.
The Wave Format window displays the format of the wave in Channels, Sample Rate, and Bits Per 

Sample.
- Double-Clicking on these windows will toggle the display between time in seconds, and in samples.

- Double-Clicking on this window will bring up the Adjust Sample Rate dialog to change the 
waveform's characteristics.

When a wave is being played via the Play button, or automatically via a keypress (see Cue List) a vertical
bar shows the current playing position.

If a valid audio CD was in the CD-ROM drive, and the [MCI] CD Audio extensions are loaded, a CD icon 
will appear on the toolbar.    If clicked, CD Player Controls will appear at the bottom of the window.



Shortcuts
KEYBOARD
Delete          Delete
CTRL+C Copy
CTRL+Insert Copy
CTRL+X Cut
SHIFT+Delete Cut
CTRL+V Paste
SHIFT+Insert Paste
CTRL+T Trim
ALT+Bksp Undo
CTRL+A Select Entire Wave
ALT+P Play waveform
ALT+S Stop play
SPACE Play waveform/Stop waveform
F2          Repeat last command (show dialog if command has one)
F3          Repeat last command now (using last used settings)
ALT+M Monitor source signal toggle on/off
ALT+I    Waveform Info
ALT+Z    Frequency Analysis Window

MOUSE
Left Click and Drag on waveform to highlight and select a range of samples
Right Click (and drag) on waveform to extend selection
Shift+Left Click (and drag) on waveform also to extend selection
Double-Click on view indicator (green bar) to enter viewing range directly in samples
Double-Click on Levels Meter (black bar) to start/stop monitoring
Double-Click on Sample type display to change sample type interpretation
Double-Click on time windows to change time format
Double-Click on title bar to Maximize/Restore
Rest mouse over toolbar button to get explanation of button's function



Opening a Waveform
Various waveform data types are supported.    Cool Edit will convert the waveform type to its own internal 
temporary file type for faster editing, and larger edit file size.    The wave can subsequently be saved in 
any of the supported formats you wish.

Checking the Auto Play box will cause any wave selected to be played if your system has a driver that 
understands the format of the wave being highlighted.    If using this option causes crashes, then don't use
it.    Your system may crash if your Windows audio drivers try to interpret a sound file that is not 
understood.    Getting new sound compression drivers should fix these sorts of problems.

Checking the Show Info box will show the waveforms basic information like file format, uncompressed file
size, and running time.

Each wave type supported is embodied in a filter (*.FLT) file.    See Wave Formats for descriptions of the 
various formats.

When opening a wave AS another format, the quick and dirty method is used.    See Open As for more 
information.



Wave File Formats
All the waveform file formats that Cool Edit understands are placed in the .FLT files.    Each .FLT file can 
contain a coder and a decoder, and all options necessary for the particular wave format.    Sometimes 
large formats like .WAV are encapsulated in many .FLT files instead of just one.    The following is a list of 
the various file formats for which I have written codecs.

Windows PCM waveform (.WAV)
All WAV formatted files follow the RIFF (Resource Information File Format) specification.    Most of the 
special information (See Info) is saved with the wave file in these formats.    The standard Windows PCM 
waveform contains PCM coded data, which is pure uncompressed pulse code modulation formatted data.

Microsoft ADPCM waveform (.WAV)
Microsoft ADPCM compressed waveform forma consists of    4-bit per channel compressed data.    Each 
4-bit sample is expanded to 16-bits when loaded.    For this reason, it is best to save 16-bit files in this 
format rather than 8-bit files as the quality will be much greater.    In the end, the 16-bit data can still be 
quickly converted to 8-bit during playback on cards that don't support 16-bit.    Choosing the Multiple Pass 
option will take longer to save, but the quality will be better.    The time taken to read an ADPCM file is the 
same no matter which option you choose.

IMA/DVI ADPCM waveform (.WAV)
This standard compresses 16-bit waves to 4-bit using a different (faster) method than Microsoft ADPCM, 
and has different distortion characteristics, which may be better, or worse, depending on the original 
sample being compressed.    Again, it is better to save 16-bit audio in this format than 8-bit.    This format 
allows for 3-bit compression as well at a slightly lower quality.    Very few sound drivers support the 3-bit 
ADPCM, and I have found none that actually work properly.    In building this format, I followed the 
specification to the letter without making any assumptions.    In the past, I have seen audio drivers that did
not play DVI compressed data properly, but lately this has been changing as other manufacturers are 
providing DVI audio drivers that can read the files saved by Cool Edit in this format just fine.    (Although I 
have yet to see a 3-bit DVI audio driver that plays stereo waves properly.)    If you have other software that
does not play files saved in this format properly, please contact the vendor and try to obtain the latest 
driver they have.

I have also implemented a 2-bit version of the compression by using the index table -1,2,-1,2.    I could not
find the specification for 2-bit compression, so it may not be compatible with other IMA/DVI 2-bit 
compressed files.    I found that the preceeding index table provided the best quality.

CCITT mu-Law and A-Law waveforms (.WAV)
These formats compresses original 16-bit audio down to 8 bits.    The quality is somewhere between 8-bit 
and 16-bit.    Thus, a-law and mu-law encoded waveforms have a higher s/n ration than 8-bit PCM, but at 
the price of a little more distortion that the original 16-bit audio.    The quality is definately higher than you 
would get with 4-bit ADPCM formats.

Sound Blaster voice file format (.VOC)
Sound Blaster and Sound Blaster Pro voice files can be loaded.    This format only supports 8-bit audio, 
mono to 44.1KHz, and stereo to 22KHz.    If the file you are loading contains loops and silence blocks, 
they will be expanded while loading.

Apple AIFF format (.AIF)
This is Apple's standard wave file format.    Cool Edit only supports the PCM encoded data, even though 
this format (like the WAV format) can contain any one of a number of data formats.    Assuming you got 
the wave over to the PC from a Mac, you can name the file with the .AIF extension, and load it using this 
file filter.    If saving files destined for the Mac in this format, you should add the four character code "AIFF"
in the file's resource fork on the Macintosh side so other Mac programs will know what type of file it is.



ASCII Text format (.TXT)
Data can be read to or written from files in a standard text format, with each sample separated by a 
carriage return and channels separated by a tab character.    Options allow data to be normalized between
-1.0 and 1.0, or written out and read in raw sample values.    An optional header can be placed before the 
data.    If there is no header text, then the data is assumed to be 16-bit signed decimal integers.    The 
header is formatted as KEYWORD:value with the keywords being: SAMPLES, BITSPERSAMPLE, 
CHANNELS, SAMPLERATE, and NORMALIZED.    The values for NORMALIZED are either TRUE or 
FALSE.    For example,

SAMPLES: 1582
BITSPERSAMPLE: 16
CHANNELS: 2
SAMPLERATE: 22050
NORMALIZED: FALSE
164 <tab> -1372
492 <tab> -876
...

8-bit signed raw format (.SAM)
Data with the .SAM extension is assumed to be 8-bit signed raw data with no header.    Sample rate is 
assumed to be 22050Hz, but the actual sample rate can be changed once loaded using Edit->Adjust 
Sample Rate.    This format is popular for building MOD files, since audio in MOD files is 8-bit signed.    
Many MOD editors allow samples to be inserted from files, or exported to files in this format.

Next/Sun CCITT mu-Law, A-Law and PCM format (.AU)
The Next/Sun format supports many data formats, but only mu-law, A-law and linear PCM data are 
supported.    The most common use for the AU file format is for compressing 16-bit data to 8-bit mu-law 
data.

SampleVision format (.SMP)
The SampleVision format only supports mono 16-bit audio.    If your data is in a different format, you will 
be asked if you want to convert it before saving.    This format supports loop points, which can be edited 
using the Cue List.    The Label of the cue must be in the format Loop n,m where n is the loop number 
from 1 to 8, and m is the mode being 0=no looping, 1=forward loop, 2=forward/back loop.    The Play List 
is used to enter the number of times to loop the cue range.    Add the cue range to the Play List, then enter
the number of times to loop.

Dialogic ADPCM (.VOX)
This is yet another 4-bit ADPCM file format.    It has been optimized for low sample rate voice, and will 
only save 8000Hz Mono 16-bit audio.    This format has no header, thus any file format with the extension 
VOX will be assumed to be in this format.

Raw PCM Data (.PCM) (*.*)
This format is simply the PCM dump of all the data for the wave.    No header information is contained in 
the file.    For this reason, you are asked to select the waveform sample rate, resolution, and number of 
channels.    By reading audio data in as PCM, practically any audio file format may be read in!    You must 
have some idea first of how many channels, and the sample rate.    The waveform will sound bad in 
different ways depending on which parameters you have mixed up.    Once the wave is loaded, and 
sounds fine, you may hear clicks at the start, end, or sometimes throughout.    The clicks are various 
header information being interpreted as a wave.    Just cut these out, and Voila!    You have read in a wave
in an unknown format!



Choosing a Directory
Choose the directory you wish to copy files to.    That's all!



Opening a Waveform As Any Format
This works just like Open except that the sample format can be specified before opening.    If the sample 
format selected is different than the native format of the wave being opened, then it will be converted, 
using the "quick-and-dirty" conversion method.    This means that if the target sample rate is different, the 
conversion will not try to pre-filter or post-filter the samples.    This function works great for opening files as
different bit rates and number of channels, but for differing sample rates, open the file normally, then use 
Convert Sample Type

After choosing the filename, choose the new sample type.    The waveform will be opened, and converted 
as it is opening.



Re-Opening a Waveform
This will reload the previously loaded waveform, replacing any changes that were made to the waveform 
being edited.    Be aware you will lose any changes you have made since the last time the wave was 
saved.



Editing Individual Channels
For stereo waveforms, it is sometimes handy to be able to copy from, and paste to individual channels.    
Normally, both Edit Left, and Edit Right are checked, meaning both channels are being edited 
simultaneously.    To edit only one channel, un-check the channel you want to preserve, so only the other 
channel is being edited.    When you do this, most of the commands are still active.    When pasting, the 
audio data is overlapped with what is already there, since inserting only on one channel will put the 
stereo-ness completely out of phase.    If this is your desired effect, use the Delay function.



Viewing Range
Selecting Edit -> Viewing Range or double-clicking on the green/black samples portion bar will bring up 
the viewing range window.

Enter the leftmost and rightmost samples that you wish to have displayed.    Use this function to highlight 
a specific number of samples by double-clicking in the wave editing area after selecting the viewing range
to "select all".    Remember, Select All only selects the viewing range, not the entire waveform.



New Instance
... Or "Give me another window"
Selecting New Instance will open another Cool-Edit window as if you opened another instance from the 
Program Manager.    This may be handy when you need a secondary window to do some editing in, and 
don't want to disturb the original wave.



Frequency Analysis
This will bring up an analysis dialog, containing a graph of the frequencies present at the insertion point 
(yellow arrow cursor), or at the center of a selection.    A Fast-Fourier-Transform is performed to determine
the frequencies present.    Also, the most prominent frequency is interpolated, and displayed below.    By 
moving the mouse over the graph area, the frequency, and percentage (just the height of the mouse 
position) are displayed.

The information in this dialog is like one "slice" or line in the Spectral View of the waveform.

If stereo data is being viewed, the left channel will be shown in Cyan while the right will show in Magenta 
(kind of Left=Blue, Right=Red like the icon).

Check the Normalize box to re-scale the graph so that the highest intensity sample reaches the top of the
graph.



Spectral Viewing
Choosing Spectral View will display waveforms by the by their frequency components.    This is a handy 
function for analyzing your audio data, to see which frequencies are most prevalent throughout your data.

The more abundant a frequency is, the brighter the color displayed will be.    Colors range from dark blue 
(next to no frequencies in this range exist) to bright yellow (frequencies in this range are very strong).    On
256 color displays, there will be more gradations between the colors.

Lower frequencies are displayed near the bottom of the display, while higher frequencies are displayed 
near the middle on to the top.    The display is linear.    White lines on the left and right divide the display 
into 1/2, 1/4, 1/8, and so on.    To top of the display represents frequencies at just below the Nyquist 
frequency, or 1/2 the sample rate.    So if a bright spot appears near the top of the display for a signal 
sampled at 22K, the frequency being represented is near 11K.

Choose Waveform View to return to original waveform view mode.



Select Wave Device
If you have multiple sound cards, or multiple output devices (such as a sound card and the PC speaker), 
choose the input and output devices you wish to use.

If your system is equipped with MIDI devices, you may also choose the MIDI in, and MIDI out sources.

The capabilities of the recording and playback devices are displayed in the given tables.

The settings are remembered in the [cool edit] section of your WIN.INI, which means if you install a new 
sound driver or card, Cool will not access it until you choose it from this dialog.



FFT Filtering
You may filter out undesired frequencies, or just keep certain desired frequencies by using the Passive 
mode.

Use the Logarithmic mode to boost or dampen frequency components.

When the Lock is not set, you can choose both an Initial and a Final filter.    Filtering will gradually go 
from the initial state to the final depending on the Transition settings.

Graph Values in dB or percentage (depending on logarithmic or passive mode) can be entered to the 
right of the graph.    These values are independent of the shape of the graph, which means that loading a 
preset will not change these two values.

The Precision Factor determines how accurate you want the filtering over time.    A low factor, means the
filter settings will change roughly, or in chunks, from the initial to the final settings.    With higher factors, 
the filter's transitions are much smoother.    In any case, the higher the precision factor, the longer it will 
take to filter your selection, but the nicer it may sound.    The FFT (Fast Fourier Transform) function takes 
a large group of samples, and filters them all at once.    The precision factor determines how many 
samples from the entire group are actually saved in the final product.    A factor of two means that half the 
samples are saved back.    A factor of 10 means that 1/10 of the samples are saved back.    Since there 
can be only one filter setting for the entire group of samples, you will want smaller groups of samples if 
the settings are varying widely over short periods of time.

The Points parameter specifies the size of the FFT to use.    For cleaner sounding filters, use higher 
values.    The maximum value currently is 8192, and the value must be a power of two.    Recommend 
values are 1024, 2048, 4096, and 8192.

Windowing Function
This is the windowing method used when filtering.    DIfferent windowing methods give different frequency 
responses.    The Hamming and Blackman windows give great overall results.    The windowing method 
determines the amount of transition width and ripple cancellation, and are in order from smallest width 
and greatest ripples to widest width and least ripples.    The filters with the least ripples are also those that
more precisely follow the drawn graph, and have the steepest slopes, even though they are wider, and 
pass more frequencies in a band-pass operation.    Try different Windows if you are not getting the effect 
you desire.

If Morph is checked, the transition from the initial filter settings to the final filter settings will actually 
"morph" from one to the other.    If this is not checked, the settings simply change linearly over time, which
means if you have a spike at 10K for the initial filter, and a spike at 1K for the final filter, the spike at 10K 
will gradually decrease, and the spike at 1K will gradually increase over time.    If morphing is on, then the 
spike will "ooze" from 10K down to 1K, passing many of the frequencies in between.

Really nice effects can be heard by simply choosing the Passive mode, and having an initial setting with 
first half of the filter at 100%, and the second half at zero for the initial filter, and the right 1/10th or so at 
100% with the rest at zero for the final filter.    This selects high frequencies for the initial configuration, 
and low frequencies for the final configuration.    To get a nice blending from high to low, choose morph to
blend the two together by including all the frequency combinations between the two filters.    To see 
exactly what is happening as the filtering changes from the initial configuration to the final, choose 
Transition to view the actual settings that will be used over the duration of your selection.

Currently, the noise floor when using this filter is at about -70dB.    That is, if you cut out a frequency 
completely, and leave complete silence, there is noise at -70dB.    I am hoping to add an HQ feature to 
bump this up to effectively -90dB.



This function supports Presets.

For best results, filter using 16-bit samples.    If your source is 8-bit, use Edit->Convert Sample 
Type to convert to the 16-bit format.    You can convert back to 8-bit when done if you are trying to 
save space.

To keep the transitions from one filtered block to the next smooth, a percentage of the previously filtered 
block is mixed with the block currently being filtered.    This will ensure that there is no added high 
frequency noise when using very narrow filters.



FFT Transition Settings
Choose how you want your sample filtered over the time of the sample.    The left of the input graph 
represents the start of your sample, while the right hand side represents the end.    You can choose how 
your selection will be filtered over the length of the selection.    The low points represent filter settings 
close to your initial filter, while the higher points represent the settings close to your final filter.    All points 
in between are a combination of your initial and final filter arrangements.

The actual graph of the filter being used at any point can be seen below.    The filter setting shown 
corresponds directly to the position of the mouse in the input graph.    By watching how the filter settings 
change as you move your mouse up and down in the graph area, you can decide whether you want a 
morphing transition, or a linear transition.    Each type of transition will give different filter settings for the 
points between your initial and final filter settings.



Morphing is generally any technique used to transform one object into another.    In the case of filter 
settings, it is a way to smoothly transform one setting (represented by a graph) to another by estimating 
all the possible combinations of the two settings.    Over time, the first setting becomes the second.    At 
some point, the setting will stop looking like the initial configuration, and start looking like the final 
configuration.    In the filtering world, this means that frequencies between the ones selected to be filtered 
will also be filtered.



In going from the initial to the final filter configuration, the points in the "in between" settings are just the 
average between the two settings.    For example, a filter setting exactly between the initial and final would
be the exact average of the initial and final filter settings.



Musical Incantations
Now you can put your clippings to music, or just harmonize a wave using a particular chord.    To choose a
clipping for your sample, select the range you wish to use as a quarter note.    If no range is selected, the 
clipboard data will be used.    Note that the clipboard data will be filled with your sample automatically 
once music is generated, thus selecting music a second time will automatically use your last sample.

This function is by no means a complete MIDI authoring studio.    It is just meant as a quick and simple 
way to put a sample to music.    The only MIDI support is in the preview playback when the Listen button 
is pressed.

How to build a song
Simply drag the notes and rests you desire to the music bar above.    To sharpen or flatten a note, drag 
the sharp (#) or flat(b) symbol on top of the note you wish to transpose.    You can move notes up or down 
after they have been placed, or pick them up to insert in a new position.    To remove a note, pick it up and
drop it off away from the bar.

Use the scroll bar to work on individual portions of the song at a time.    You can scroll to write a piece as 
long as 256 notes.

Tempo
The tempo is given in quarter notes (beats) per minute.    Your sample's length is the length of a quarter 
note.    If your note is longer than the period determined by the tempo, then the notes will overlap.

Key
You may choose to have your music interpreted in any of the standard key signatures.    The key of C is 
the standard (white keys).

Constant Duration
If chosen, all notes will be the same length as the original sample, regardless of pitch.    The operation that
does this takes longer to calculate, but high pitched notes will be the same length as lower pitched notes.  
The Interval Overlap method is used with an overlap of 80% and an interval of 30 Hz.    If not checked, the
note is created by directly stretching or compressing the original sample, resulting in higher pitches being 
shorter than lower pitches.

Exact Tune
Choose Exact Tune to tune your sample so that when played at A (above middle C), the frequency of your
sample is at 440Hz.    If this is not checked, your sample's original frequency will be played at A (above 
middle C).

Chords
The triplets of numbers to the right is the chord selection box.    You can choose to make a chord out of 2, 
3, or 4 notes, then choose the chord from the list.    Finally, pick up a chord object (the 3 notes on top of 
each other) and drop it on a note above.    The note you drop it on will be the starting note of the chord, 
and the other notes will automatically appear above it in the right ratios.

Clearing Chords, Sharps, or Flats
If you want to clear a sharp, flat, or chord from a note, use the faded looking quarter-note object, and drop
it on the note you wish to bring back to normal.

Saving Your Songs
If you make a cool song you want to keep, give it a name in the Song Title box.    In the future, you can 
choose your song from the list of song titles that you created.    The actual song data is saved in the file 
SONGS.INI in your Windows directory.



Listen
If you have MIDI play capabilities, you can listen to a preview of your song before actually creating it.    
Play begins at the leftmost note visible on the staff, which means play begins at the position you are 
scrolled to, and continues on to the end of the song.    The music is played through channels 1 and 13 for 
Extended and Base level compatibility.    The instrument can be chosen by typing its instrument number to
the left.    You can record music played by the listen preview button.    Simply hit the record button first, 
then go into the music dialog and press Listen.    When the song is done, hit Cancel, and then Stop to stop
the recorder.

Pink
What the heck is this button for?    Well, it automatically plays the chosen instrument through the MIDI, 
using pink noise as the source for randomness.    Maybe once out of 1 million tries, it may actually write a 
cool song?    Tempo, Octave, and Key all affect the play of "pink" music.    The only purpose for this button 
I have found so far, is to open the Play List first, then open the music dialog.    While listening to a relaxing
soundscape from the play list, you can listen to relaxing random music at the same time. (?) (!)



Saving a Waveform
Waveforms can be saved in many formats.    Having many format options gives you the chance to save 
the waveform in the smallest amount of space while still retaining a high level of quality.    PCM formats 
are the only kind that save the entire wave completely with no data loss.    ADPCM formats lose some of 
the original waveform information and the waves sound a little distorted.    Mu-Law and A-Law formats 
also lose some of the information, but it may not be as noticeable as ADPCM, but it depends on the type 
of audio that is being saved.

Some file formats support various options that can be modified by pressing Options.

See Wave Formats for a list of supported formats.



Saving the Highlighted Selection
Saving a wave selection is identical to Save except that the highlighted selection is saved, and not the 
entire waveform.



Immediately Saving a Waveform
Choosing Save from the File menu will save the current waveform back to disk, overwriting the original 
without confirmation.

The disk icon in the toolbar can be set to save immediately, or to bring up the Save As box depending on 
the setting in the Settings    section.



Repeat Last Command 
Pressing F2 or this will repeat the last function that modified waveform data.

Press F3 to repeat the command immediately, bypassing any settings dialogs.



Settings
Disk Icon Interpretation
The Disk icon can be interpreted as:
- Save Now (saves what you are working on under the same filename seen in the title bar without asking 
if you wish to overwrite the original) or
- Save As (Always brings up the Save As dialog box to enter the title to save the file as)

Viewing Mode
When zoomed in closely to a wave, individual samples can appear as dots, or as a continuous line.

Play/Record Buffer Size
The number of seconds to reserve memory for recording and playback.    Increasing this will allow more 
multitasking while audio is being played, but it takes more memory.    If this value is too small, there may 
be too much choppiness in your recordings and playbacks.    If your recordings are getting all "chopped 
up", or you cannot Stop after you've started recording, increase the buffer size, or switch to a faster hard 
drive (Use a non-compressed hard drive for example).

Temp Directory
This is the location that Cool Edit will use to save all of the temporary files, which includes the disk image 
of the file currently being edited.    It is best to choose a large, fast hard drive for this.    If you no for certain
that the drive is not compressed, then do not check the Compressed Drive box, otherwise check this 
box.    If you have trouble recording high quality audio for more than a minute (or even less), then    make 
sure the Compressed Drive box is not checked.    When checked, DOS is asked for the number of bytes 
remaining on the hard drive since this value does not change linearly with time on compressed drives.

Highlight After Paste
After doing any Paste operation (this includes Paste Special), you can have the inserted selection 
automatically highlighted, or just have the cursor at the end of the pasted selection.    Not highlighting after
pasting makes it easier to do multiple pastes one after the other.

Pre-compute Trig Tables
If you are not using a co-processor, or a 486 or better machine, some functions will run faster if this is 
checked.    Tables for trigonometric functions are computed once, and used during the Wave, Flange, and 
Generate Tone functions.

Play 16-bit files as 8-bit
If your sound board is only capable of 8-bit audio, you can still create and edit 16-bit audio files.    When 
you choose Play, the audio data will be converted to 8-bit before being sent to the sound board.

Enable Undo
If this is checked, the undo function is enabled and running.    After making a change, you can choose 
Edit -> Undo to back up one step.    You may want to disable the undo feature if you know you are not 
going to undo something.    For example, if you are running a function on a 5 minute file, you may not 
want to wait while the undo information is saved.

NT Display Compatibility
If this is checked, then the program "locks" while the green waveform is being drawn.    With Windows NT, 
other apps are not paused when this is going on, and the extra code needed to "multitask" with other 
apps does not need to run.    If you are running Windows NT, and this is not checked, you may experience
various screen redraw problems.

Smooth 16-bit to 8-bit Conversions
If checked, when 16-bit audio is pasted into an 8-bit waveform, or 16-bit audio is Opened As 8-bit, the 16-
bit audio is dithered down to 8-bit to retain more of the original signal.    Dithering can keep some of the 



audio audable that is below the threshold for 8-bit audio.    When doing this, you may notice a bit more 
noise in the background, but the noise is constant, and you can hear some of the 16-bit audio in the noise
that was otherwise inaudable.    If this dithering is not done, you will notice strange artifacts in quiet audio. 
Most prefer to have a constant background noise rather than have strange sounding artifacts in the 
background.    Distortion sounds "crackly" if no dithering is used, or else the sounds have a constant hiss 
if dithering is used.

Enable Toolbar Help
When the mouse is over a toolbar button for more than a few hundred milliseconds, a small help box 
appears to describe the button's function.    Anyway, if it is annoying for you, you can turn it off here.

Play from cursor
When no selection is highlighted, audio can be either played from the current cursor location to the end of
the view, or always from the left edge of the view to the end of the view.

Time Code Display
Double-clicking on the time boxes will change their display format.    When in 
Hours:Minutes:Seconds:Frames format, you can customize the number of frames per second that will be 
displayed.

Spectrum Analyzer Resolution
This is the number of bits of accuracy to display the spectral analysis when Edit->Spectral View is 
chosen.    Each bit will take approximatly twice as long to draw, but the resolution will be more precise.    
The number of data points displayed is equal to 1/2 of two to the value given.    In other words, a value of 
7 will display 64 points along the y axis, a value of 8 will display 128, 9 for 256, 10 for 512 and so on.    On
most displays, a value of 10 ias high as you will ever need to go.



Cue List
A cue list is a list of time offsets into the wave file.    A cue can be either a point, specifying a cursor 
position, or a range, specifying a selection.    You can easily jump to a cue position in a wave by double-
clicking on the position in the list, or selecting the cue position, and pressing Goto.    Cue ranges can later 
be arranged in a play list to be played back in any order, with a specific number of loops if desired.    A 
maximum of 96 cues may be entered.

<- Add
Add the currently highlighted selection, or cursor position to the cue list.    Items will be displayed in 
temporal order, with the earliest cue position at the top of the list.

Remove
Remove the selected cue position from the list.

Label
Short text label describing the selection.

Description
A textual description of the wave data if necessary.    Also can be used as a comment.

Goto
Goto the selected cue position, or highlight the selected range.    Double clicking a cue item acts as if 
Goto were pressed for that item.

The cue list is saved in the .WAV file format in the 'cue ' chunk.    Additional information about the cue 
position, like label, description, and length of sample, are placed in the 'adtl' list in the 'labl', 'note', and 
'ltxt' chunks.

Markers
The cue list can be used anytime to mark your current selection so you can return to it later.    If you would
like Cool Edit to remember your highlighted selection, or just your current cursor point, click Add in the 
cue list, and quickly type a name for your selection.    In the future, if you want to return the cursor to that 
point, or re-highlight that selection, double-click the name or choose the name and click Goto.    One great
use for markers is to highlight a wave from the zero crossings.    Go to the start of wave portion you wish 
to highlight, and zoom in as far as needed to position the cursor exactly on the zero-crossing point.    Add 
that position to the cue list.    Now zoom out, go to the end of the wave portion, and once again zoom in to 
find the ending zero crossing.    Now, double-click on marker name in the cue list, hold down on the Shift 
key to extend the selection, and click on the ending zero crossing.    Voila!    You can choose "Zoom In" 
now to see your wave portion if you like... it is now selected.

Assigning Cue Ranges To Keys
If you wish to assign any cue range you have added to a key on the keyboard, give the cue range a label 
of the form KEY N, where N is any key on the keyboard (capital letters only).    When you go back to 
editing the waveform, pressing the key will play the cue range you selected.    You can assign any portion 
of the waveform to any key on the keyboard.



Play List
The play list is a listing of cue ranges that can be played in any order, and looped a specified number of 
times.    The play list is used in conjunction with the cue list.    Maximum size of a play list is 64 entries.

<- Add Before
Add the currently highlighted selection from the cue list to the play list.    The selection is inserted before 
the currently highlighted play list item, or at the end if nothing is selected.

Remove
Remove the selected play list item from the list.

Loops
The number of loops to loop the selected cue range in the play list.

Play
Play the cue ranges in the order listed, looping selections if necessary.    Play begins at the currently 
highlighted item in the play list, or the entire list is played if [end] is selected, or there is no selection.

Autocue
Play the currently highlighted item in the play list (or the first item if nothing is highlighted), looping if 
necessary, and stop on the next item in the play list.    Thus, every time Autocue is pressed, the next item 
in the play list is played.

The play list is saved in the .WAV file format in the 'plst' chunk



Reverse
This does just as you'd expect.    Select a portion of the wave using the mouse, and select Reverse from 
the Transform menu to reverse your wave.



Trim
Trim is the exact opposite of delete, which means everything is deleted except the portion that is selected.
Only the selected portion is kept.    This is handy to quickly pick out the part of a recording you want to 
keep.

Use CTRL+T to quickly trim the selected portion of the wave.



Editing Channels of Stereo Waveforms
When fully implemented, you will be able to make edits (copy, paste, etc. and so on) to only one channel, 
completely independent of the other.



Digital Delay
Delay either channel up to 50 milliseconds with the option to mix in the original signal with the delayed 
signal.    Great for effects such as spatially locating a previously mono wavesource to the left or to the 
right, so that the sound will appear to emanate from that direction when listened to with stereo 
headphones.    Delays of longer than 50 ms may be entered for creating a single echo.    

Delay (ms)
The actual amount of time to delay the channel in question.

Mixing
You may choose to have the resultant wave the delayed signal, keep it the original signal, or mix the two.  
A value of 50 will mix the two evenly.

Invert
The delayed signal may be an inverse of the original if this is checked.    More special effects!

This function supports Presets.

Tunnel Preset
The Tunnel preset can be used with mono as well as stereo waveforms.    The settings provided give a 
nice tunnel/tubular effect.

Spatial Left Preset
If a mono wavesource was converted to stereo (so that the left and right channels are the same), then 
choosing this will make the sound appear as if it is coming from the left, since the right channel is delayed
just enough so your brain interprets the sound as coming from the left.    You must use headphones to 
hear the effect.

Spatial Right Preset
The same as Spatial Left, but it locates the sound to appear as if it is coming from the right.



Stretch
You can choose the initial stretching percent (less than 100% will compress the wave), and the final 
stretching percent.    By having two separate values for start and end, the wave can be stretched linearly 
from one ratio to another.    This gives the effect of slowing down and speeding up, or raising and lowering
pitch.

Preserve Pitch
Lower percentages will slow down the tempo, while higher ones will increase the tempo.    The pitch 
remains the same throughout.

Preserve Tempo
The tempo or speed of play will remain the same.    The only thing affected will be the pitch.    Higher 
percentages will lower the pitch, and lower percentages will increase the pitch.    Try using differing initial 
and final percentages to raise and lower the pitch without affecting the tempo.    First the selection is 
adjusted, preserving the pitch, then the selection is squeezed or expanded, with no preservation.

Preserve None
The tempo will slow, while at the same time the pitch will lower if percentages above 100 are used.    For 
lower percentages, the tempo will speed up and the pitch will increase.

Transpose
When the number of desired keys up or down are chosen, the numerical values for transposing musically 
are entered into the stretch sliders.    For example, to make your sound as if it were the next key higher (if 
played on a keyboard, and black keys included) choose 1# for 1 sharp.    The 'b' values will flatten or lower
your sound.

Interval Overlap
When preserving pitch or tempo, the waveform must be elongated or truncated smoothly and preserve as
much of the original information without adding noticable distortion.    This is one of two methods that can 
be used to achieve this.    The amount of distortion introduced is not dependent on the type of sample (eg 
music or speech).    When stretching or compressing, the appropriate chunk from the original wave is 
output to the transformed wave, and overlapped with the previously transformed chunk.    

The interval rate determines the size of a 'chunk' of audio data.    Interval rates will become an audible 
hollow sound when large rates (above 50Hz) are used.    If the rate is too low, echoing will be very 
noticable when raising pitch, or slowing down tempo, or chopped sylables will be noticable when lowering 
pitch, or speeding up tempo.    Values of 20Hz to 40Hz usually produce good results.

The overlapping determines how much of the previous chunk is overlapped with the current chunk.    The
overlapping can produce a chorus effect.    To reduce the chorus effect, lower the overlapping percentage. 
When the overlapping is reduced, a choppiness to the sound may appear.    Adjust the overlapping to your
taste to strike a balance between chopiness and chorusing.    Overlapping can be as high as about 400%, 
but only use this for really high speed increases (like 200% or more).

Fractional Interval Overlap
This second method of preserving pitch or tempo uses a more straightforward algorithm which 
guarantees the timing to be as close as the interval rate allows.    This usually causes more of a 
reverb/echo effect with the audio, but in cases where stretching is being done at rates lower than 60 
percent, or higher than 175 percent, this method can produce more desireable results..

The interval rate determines the size of the chunk of audio data in the final stretched wave.    If there are 
any artifacts, they will be heard at this frequency.    For example, an interval rate of 60Hz will cause a 
60Hz distortion artifact.    Values of 15 down to 7 or so seem to work best.    The higher the value, the 
more precise the placement of stretched audio over time, but also the artifacts are more noticeable as 



rates go up.

The overlapping determines how much the current chunk overlaps with the previous and next chunks.    
The maximum overlapping allowed can be as great as 1000%, in which up to 10 sections of the wave are 
overlapped together.

If using either of the Interval Overlap methods, you can improve the quality of the stretched audio of mono
tonal (pure tone) samples by choosing an Interval Rate that is evenly divisible into the frequency of the 
sample.    Use the Frequency Analysis window to find the sample's base frequency, then divide by an 
integer to get the Interval Rate.    For example, if the tone was reported to be 438Hz, dividing by 20 gives 
21.9Hz, so using 21.9Hz for the Interval Rate will greatly improve the quality by reducing the phasing 
artifacts.    For very non-tonal or noisy samples, the Interval Rate does not matter as much.

Zero Splicing
This is the third method of preserving pitch or tempo.    Less distortion is noticed when using samples that 
were derived from one source, and contain a relatively low number of fundamental frequencies.    For 
example, a single instrument, or speech will work OK, while an orchestra or music will not work as well.    
When stretching or compressing,    the wave is broken up into chunks that begin and end when the 
waveform crosses zero, or the midpoint.    Chunks are repeated, or thrown out depending on the 
compression ratio and the cutoff frequency.    Chunks smaller than the cutoff frequency will not be 
thrown out or repeated.    Try cutoff frequencies between 50Hz and 300Hz for best results using this 
method.

This function supports Presets.

Raise Pitch Preset
This will adjust the settings so that the pitch of the sample will be raised by 1/4 octave.

Lower Pitch Preset
This will adjust the settings so that the pitch will be lowered by 1/4 octave.

Speed Up Preset
This will speed up the sample, so talking will be faster, but the pitch will be unaffected.

Slow Down Preset
Slows down the sample.

Note:    An alternative method of stretching while preserving pitch or tempo is to do an FFT, and modify the
amplitudes and phases of each frequency in the frequency domain, and then do the inverse FFT to 
translate back.    This method would be very complex, and be very very much slower than the methods 
currently being used.    If you want to experiment some, try the /i Shift option in the Filter function does this
in a very crude way, by just shifting the frequencies up without regard to their phase.



Compact Disc Player
If you have the [MCI] CD Audio driver loaded, you can control the CD player with a standard set of 
control icons.    You can also name your CD, and the individual songs as well for display the next time you 
use the same CD.

Tracks List
Click on any track number to start playing that track.

Time Readout
Displays the current time in minutes:seconds into the current track.

Title Display
Displays the title of the CD.    The title defaults to the length of the CD.    You can type in the proper title of 
the CD here.    If a track is currently being played (if the track number is highlighted in the track list), then 
the title reflects the title of the current song.    As you are entering song titles, you may use the TAB key to 
jump to the next song to easily enter the titles for the entire CD.    Titles are saved in the file(s) 
COOLCDx.INI where x ranges from 0 to 99.    Once one of the COOLCDx.INI files reaches about 64K in 
size, the next file is used for storing new data.    This keeps the size of each INI file below 64K which is a 
Windows requirement.    Song titles in the file MUSICBOX.INI in your Windows directory will also be 
displayed properly, and can be edited from within Cool Edit as well.    Using this method, thousands and 
thousands of CDs can be entered completely without fear of losing your favorite tracks.

[Stop] 
Square Box:    Stops CD playing.    Play will resume at the start of the CD.

[Pause]
Vertical Bars:    Pauses the CD.    Play will resume at the same location.    This button will turn into a Play 
button when pressed so that play can be resumed by pressing it.

[Play] 
Right Arrow:    Starts the CD either at the beginning of the disk, or at the paused location.    This button will
turn into a Pause button when pressed, so that play can be paused by pressing it.

[Scan Back]
Double Left Arrows:    Rewinds the CD 10 seconds.

[Scan Forward]
Double Right Arrows:    Forwards the CD 10 seconds.

[Mark]
Red X:    Mark the location currently being played.

[Goto Mark]
Arrow to Red X:    Go to the location that was marked earlier.

[Eject]
CD Ejecting:    Spit out the CD if that is possible on your player.    The icon changes to [Insert] if no CD is 
in the drive, and if your drive can do it, the CD will insert when you press the button.



Selecting Exit, or double-clicking the system menu box will close the program.    At close time, any 
temporary files that were created will be removed.



RIFF Info
Extra information can be included in your .WAV files using the RIFF LIST INFO and DISP type 1 formats.   
This information should (depending on future wave editors) stay with your sound through it's lifetime.    
Wave editors should preserve some of the fields you see here.    Be sure to put proper information in it's 
place!

Display Title
This should describe the sound, or text (if there are words in the wave).    This field should be as short as 
possible, since it will be displayed in OLE objects and the like.

Icon
Any DIB or BMP file can be inserted, but preferable a 32 X 32 16-color would be best.    The Media 
browser uses this size to display a picture representing the sound.    Other OLE compatible applications 
can use the above display title, and/or the bitmap to represent your waveform.

Original Artist
The one who created the sound initially.    Examples are:    Beatles, Pat Sejek, Fred Flinstone

Name
The title of the wave.    This is your chance to put a name with your audio "artwork".    Examples are:    
Thunderstorm At Night, Forest Stream

Genre
The Genre of the original work.    With audio, let's try things like musical classifications, etc.    Examples 
are:    Cartoon Voice, New Age, Instrument

Key Words
In the future, sounds may be searched for by key words.    Please separate key words by a semicolon 
followed by a space.    For Example:    Violin; Hayden; Johann Strauss

Digitization Source
Where was the sound digitized from.    A tape deck, CD, or maybe directly from a microphone?    Maybe 
describe the board used here too, like Sound Blaster Pro, or MediaVision.    For Example:    DDD CD to 
MediaVision Pro 16

Original Medium
Where did the sound come from originally.    Examples:    Live Band, Flute, Moog, Voice

Engineers
Store the name(s) of the engineer(s) who worked on the file, or edited the file.    Please separate names 
by a semicolon and a space.    When a new person edits the file, they can add their name to the list.    For 
example:    John Cravitz; Fred Millstone

Digitizer
Who is the technition that did the actual digitizing?    They should put their name right here.

Comments
This is for making any comments you wish.    Feel free to include any special effects or enhancements 
you made to any preexisting waves so that the editing history can be tracked.    Please do not use any line
returns.    End each sentence with a period.    For Example:    It took me 12 hours to get this recording 
right.    John added echoing effects using Cool Edit.

Subject
This Describes the content of the file.    Feel free to include a description of the instruments used, where 



someone can find the song recorded, etc.    Line returns are OK, and are created by pressing Ctrl+J.    
Sometimes copyright information is placed here as well.    For Example:    The shakuhachi of 
Japan.<Ctrl+J><Ctrl+J>The shakuhachi was developed in the 15th century from a Chinese end-blown 
flute, called the chiba.

Source Supplier
The name of the person, or organization who supplied the original source material.    Let's use this field for
the names of record companies, or whoever supplied you with the source.    Examples:    MCA Records, 
Ann Wilson (if recorded live)

Copyright
Any copyright information for this file should go here.    Example:    (c)1992 G. Willikers Corporation. All 
rights reserved.

Software Package
The software used to digitize and edit this file.

Creation Date
The date that the subject matter was created.    The date should be in the format yyyy-mm-dd, using '0' as
a place holder in single digit values.    For example, if the date the original recording was made was July 
30, 1988 then it would be written as:    1988-06-30 
 



Embedding Bitmaps in WAVs
Any DIB or BMP bitmap can be inserted into the wave file.    The bitmap will only be saved if the file is 
saved as WAV.    Icon sized bitmaps (32 X 32) are preferable, since they are easier to display by other 
OLE aware applications.    OLE applications may represent your wave file using the bitmap you select.



Cut
Cut will copy the selected range to the clipboard, and remove it from the waveform being edited.    Once 
in the clipboard, it can be pasted or special pasted to waveforms, or pasted to other applications that 
support the CF_WAVE clilpboard format.

Use CTRL+X or SHIFT+Delete to quickly cut the selected wave.



Envelope
By using an envelope, you have great control over which parts of your wave are amplified, and by how 
much.    A point at the top of the graph is 100% (normal) amplification, and at the bottom is no 
amplification (silence).    This function is handy when modifying Tones generated with this program to 
create more realistic sounding instruments and effects.

Amplification
Adjust this value to amplify more than 100%.    This value changes the values represented by the graph.

Click in the graph area to add control points.    You can drag control points up and down.    Drag a control 
point off the graph area to remove it.

This function supports Presets.

Note:    This function relies on the AMPLIFY.XFM module for doing the actual amplification.



Generate Silence
Enter the number of seconds of silence desired to generate that amount of silence at the insertion point.

Pretty simple, eh?



Silence
Choosing this will silence out the selected material.

Just about as simple as Generate Silence, huh?



Generate DTMF Signals
This function generates Dual Tone Multi-Frequency (DTMF) signals used for dialing telephone numbers 
over the PSTN.    These signals are recommended internationally by the International Telegraph and 
Telephone Consultave Committee (CCITT) as the signals for push-button telephones.    The DTMF signals
generated by telephone push-button keypads are different from the Multi-Frequency (MF) tones 
generated by the telephone network to transmit information.

Dial String
Enter the phone number you wish to generate the tones for in this box.    Other characters may be entered
such as the '*' and the '#' symbols, as well as extra digits 'a', 'b', 'c', and 'd'.    Entering the pause character
(defined below) will insert a pause of the length defined.

Tone Time
All tones will last the milliseconds entered.    The standard time for DTMF tones is 100ms.

Break Time
This is the number of milliseconds between successive tones.

Pause Time
This is the number of milliseconds to use for a pause (when the pause character is used in the string).

Pause Character
When this character is typed in the Dial String, it will be interpreted as a pause, and silence will be 
inserted for the duration of the Pause Time.

DTMF Signals
DTMF (normal push-button telephone type) signals will be generated using combinations of the 
frequencies 697Hz, 770Hz, 852Hz, 941Hz and 1209Hz, 1336Hz, 1477Hz, 1633Hz.

MF Signals (CCITT R1)
MF (internal to telephone networks) signals will be generated using paired combinations of the 
frequencies 700Hz, 900Hz, 1100Hz, 1300Hz, 1500Hz, and 1700Hz.

Amplitude
The volume level of the tones being generated, with 100% being maximum volume without clipping.

The presets in this function save everything, including the dial string.    To see how effective these tones 
are, try typing in your favorite phone number to generate the tones for it.    Then hold the receiver of your 
phone next to the speaker and play the wave.    It will dial the number you had entered!



Generate Tones
Generating tones is a great way to provide a base sound to create spectacular special sound effects.

Base Frequency
The main frequency (F) that will be used for sound generation.

Modulate By
Enter the variation in frequency you wish to hear.    For example, choosing 100 will oscillate the tone being
generated between 50 minus and 50 plus the base frequency.

Modulation Frequency
This is the rate (times per second) at which the frequency modulates.    Entering a value of 10, for 
example, will generate tones that warble at the rate of 10 times per second.

Flavor
Choose the type of waveform to use.    Sine waves sound soft, while Triangle and Sawtooth waves are 
sharper.    Each flavor has a particular sound unique unto itself.      

Modulate over Source
If a selection was highlighted, it will be modulated by the tones based on the normal tones settings.    
Instead of generating new tones, the currently highlighted wave data will be "ring modulated" by 
multiplying the tone by the data underneath.    This is great for adding really weird special effects.

Stereo Phasing
The left channel can be out of phase with the right channel.    If you wish this, choose the amount of phase
shift here.    A value of 180 will be completely out of phase.

Duration
This is how many seconds of tones you wish to produce.

Frequency Components and Multipliers
You can choose up to 5 overtones, and mix them at any proportion, and change the multiplier used to 
gain the overtone's frequency.    If Lock is not checked, all these can change over the durtion of the signal 
from initial to final settings.    The value entered below the overtone slider is the frequency multiplier.    The
actual frequency will be this many times the base frequency.    Moving the slider from 0 to 100% changes 
the ratio this slider's frequency with respect to the others.    Lots of really great effects can be generated 
with just these 5 overtones.    Just experiment and have fun!    

Lock
If checked, the overtones, base frequency, modulation, modulation frequency, frequency multipliers, and 
overtone intensities are constant -- they do not vary over time.    Uncheck this box to dynamically change 
the proportion of any overtone over time by choosing the inital and final proportions.    You can also 
dynamically change the frequency multipliers, base frequency, modulation, and modulation frequency for 
interesting effects.

Initial and Final
You can choose to adjust the initial or final overtone proportion settings when the overtones vary over 
time.    You can also choose different base frequencies, modulations, and modulation frequencies.

Flip
Check (or uncheck) Flip to swap the initial and final settings.    This is very useful if you wish to generate 
another tone after the last tone that was just generated.    Whatever overtone settings the last tone had as
the final settings can be used as the initial settings on this tone by clicking Flip.    All you need to do is click
Final, and enter new final overtone values.    This way the tones will flow together smoothly.



Volume
The Volume sliders are used to select how intense the tones will be in each channel.    Both channels can 
be controlled independently when generating stereo tones.

This function supports Presets.

Experiment with all the settings for various wild effects.

... and Have Fun!



Paste
paste will insert the wave from the clipboard at the current insertion point, replacing any waveform data in
the selected range.    If the format of the waveform data in the clipboard differs from the format it is being 
pasted into, it will be converted accordingly before pasting occurs.

Use CTRL+V or SHIFT+Insert to quickly paste the waveform that is on the clipboard.



Delete Selection
Once a range is Selected, it can be removed by choosing this option.    The deleted portion is not copied 
to the clipboard.    It is gone forever.



Quick Filter
The 8-band quick filter allows one to customize to suit most filtering needs.    The "equalizer" works pretty 
much the same as a standard audio equalizer does.    Except that the bands are not the same as you 
would expect.    The highest frequency band will increase or decrease the high end, but it will also 
increase frequencies all the way down to the lowest as well, but it will increase the high frequencies more 
than the low ones.    The effect is close to an equalizer, but not quite.    Basically, this is a handy function 
for changing the tone of your sample (such as noise) to make it more pleasing to the ears.    

Equalizer Bars
Adjusting these increases or decreases the frequency component specified beneath the bar.

Volume Bars
The final volume after equalizing may be adjusted to suit your needs.    Checking the Lock Vol checkbox 
will lock the left and right scroll bars.

Flat
This simply places all equalization values plus volume adjust at 100%

Lock Initial/Final
When locked, the entire selected range is equalized with the setting shown.    If unchecked, the initial and 
final equalization settings may be adjusted, so the selection can smoothly glide from the initial 
equalization setting to the final setting over the range selected.

View Initial
When Initial/Final is not locked, choose this to select the initial equalization settings.

View Final
When Initial/Final is not locked, choose this to select the final equalization settings.

This function supports Presets.

To produce a semi low-pass filter, set the higher frequency scroll bars to zero to cut out higher 
frequencies.    A high pass filter can be done in the reverse fashion, by zeroing out the lower frequencies.

Very interesting effects can be made by selecting widely varying initial and final equalization settings.

Note:    Setting the lower bands to very high values can, and most times will, result in clipping if the 
volume adjustment is not turned down.

For serious filtering, see Filter.



Copy
Waves can be copied to the clipboard to be pasted later using this program, or any other application that 
supports the CF_WAVE clipboard wave format.    Before copying, the portion that is to be copied must first
be selected.

Extra large waves may not be able to be copied.    If this happens, try breaking up the selected range into 
smaller portions and copy/paste them in multiple steps.

Use CTRL+C or CTRL+Insert to quickly copy the wave.



Amplify
Amplify will increase or decrease the volume of the selected sample.

Initial Amplification
This is the amplification that will affect the beginning of the selection.    Choose a separate final 
amplification for fading up/down effects.    An amplification value of 100 will keep the signal unchanged.

Final Amplification
This is the amplification that will affect the ending of the selection.    Setting both the initial and final 
amplifications to the same value will amplify the entire selection the same amount.

Lock Left/Right
Left and Right channels may be amplified at separate values.    If the Lock is checked, then the scroll bars
for the left and right channels are locked to the same value.    Effects such as panning from left to right 
can be achieved by choosing separate values for the left and right channels.

Logarithmic Fades
Also known as Power fades.    When checked, the power of the signal fades at a constant rate.    When 
not checked, the sample values fade linearly.    As seen on screen, linear fades look like a flat slope, while
power fades usually look like a hill that starts steep and gets less steep as time goes on (or the opposite 
depending on whether you are fading in or out).

dB Scale
When checked, amplification values are entered in decibels, otherwise they are entered as a percent of 
the original waveform.

DC Bias Adjust
Adjust the waveform so it is centered on the center line (0 %).    If samples are recorded with a DC Bias, 
they will appear to be above or below the center line.    They must be centered before doing other 
waveform transformations, and choosing this will center the wave properly.    To skew the entire selected 
waveform above the center line, enter the percentage to move the waveform up in the adjustment box.    
For example, 50% will move the entire waveform up half way, and a -50% will move it down half way.

Normalize
Pressing the Normalize button will calculate the greatest amplification for the sample that will not result in 
clipping when set to 100%.    If the left and right scroll bars are not locked, separate left and right values 
will be computed, potentially amplifying one channel more than the other.    To normalize to less than the 
maximum range, enter the percentage of maximum to normalize to.    For example, choosing 50% will 
compute values needed to amplify the file no more than 50% of maximum, resulting in a 3dB diminuation 
from maximum output.    If two sounds normalized to 50% are overlapped, the resultant wave is 
guaranteed not to exceed the boundaries, and will not clip.    All this button does is recalculate the 
amplification values for you based on how much normalization is needed.    To normalize in one step, use 
the Normalize function.

To achieve a fading in effect, choose an initial amplification of 0, and a final amplification of 100.    For 
fade outs, do the opposite by setting the initial to 100 and the final to 0.

Note:    This Normalize button only calculates the values needed for the desired normalization.    If you are 
recording a script, only the final values will be remembered.    If you want to add normalization to a script, 
use the Normalize function instead.

This function supports Presets.

Fade In Preset



Initial amplification is set to zero, and final is set to 100 for a fading in effect.

Fade Out Preset
Initial amplification is set to 100, and final is set to zero for a fading out effect.

Pan L->R, Pan R->L Preset
Initial and final values are set so that the sound starts at one channel and pans to the other.



Echo... echo... o...
Create echoing and reverb effects.    This function creates a continuous echo.    Each successive echo 
decays in amplitude by the falloff ratio.    To create the effect of a single echo, use the Delay function 
instead.

Falloff Ratio
Each successive echo will be a certain percentage less than the previous one.    Choosing a falloff ratio of 
zero would result in no echo at all, while choosing a ratio of 100 would produce an echo which never gets 
quieter.

Delay
This is the number of milliseconds to place between each echo.    A delay of 100 milliseconds is equivalent
to a 1/10th of a second pause between echoes.    Choosing very small values of delay produces quite 
interesting effects.

Initial echo volume
This is the volume at which the echoes will be mixed with the original sample.    Choosing smaller 
percentages (30% or so) is nice if the effects of the echoing at 100% make the sound incomprehensible.

Continue beyond selection
Choosing to continue beyond selection will echo the highlighted selection over the rest of the 
unhighlighted area, stopping at the right-hand edge of the wave that can be seen in the window.    If the 
window is zoomed in, the echoing will stop before the end of the file, since it will stop at the right hand 
side of the portion on screen.    By using this option a single word, for example, can be highlighted and 
echoed over other audio, without echoing the other audio as well.

Echo Left to Right
Selecting this option will make the echoes travel back and forth between the left and right channels.

If you wish to echo the right channel only, select an initial echo volume of 100% for the right, and 0% for 
the left.

Equalizer
The echo "quick filter" lets you choose approximately which frequencies get removed from the echo first.   
A setting of zero will leave the frequency band unchanged.    You can choose the frequencies that are 
"absorbed" as the echo progresses.    The echoed sample is re-filtered through the quick filter on each 
successive echo.    Setting all values to zero turns off the equalization, since no frequencies are to be 
absorbed.

This function supports Presets.



Flanger
What is flanging you ask?    Just try it out and see!    The term is coined from the flanging mechanism on 
the old style tape recorders which, when fiddled with, would slow down the playing of the tape, and speed
it back up again when desired.    That is how they got those funky psychedelic sounding recordings in the 
60's.    Here's how you can do it today.

Original - Delayed slide
This slide decides at what proportions to mix the original and flanged signal.    If the Original is at 100%, 
no flanging is heard.    If the Delayed is at 100%, a cute wavering (like a bad tape player) sound is heard.   
Portions of both signals need to be present for there to be cancelling out, and reinforcing of wave patterns
between the two signals.

Initial Delay
Flanging will start with the delayed signal this many milliseconds behind the original.

Final Delay
Flanging will end with the delayed signal this many milliseconds behind the original.    If the delays are the 
same, the effect disappears, since the delayed signal will not change.

Stereo Phasing
The right channel can be at a separate delay than the left channel.    A phasing of 180 will put the right 
channel at the initial delay value when the left channel is at the final delay value, and vica versa.

Rate settings
The Frequency, Period, and Cycles settings are all interrelated, and refer to the rate at which the delay 
cycles between the initial delay and the final delay.    The flanging will cycle frequency times per second, 
or period seconds per complete cycle, or a total of cycles complete cycles over the entire selection.    
Various effects can be heard by using different settings.    For example, if 0.5 cycles is chosen, the 
selection will start with the initial delay, and end with the final delay.    If a frequency of 4 is chosen, the 
flanging will cycle from the initial delay to the final delay and back again 4 times per second.

Invert
Invert the delayed signal when flanging, which causes the waves to cancel out periodically, instead of 
reinforcing.    If the mixing is at 50/50 then whenever the delay is at zero, the waves will cancel out to 
silence.

Special EFX
A mixture of both normal and inverted flanging, with the delayed signal summed, and a future signal 
subtracted out.    So this option will mix not only a delayed signal, but a future one as well.

Sinusoidal
If checked, the transition from initial delay to final delay and back will follow a sine curve.    Otherwise, the 
transition is linear, and delays from the initial setting to the final setting at a constant rate.    With 
sinusoidal checked, the signal is at the initial and final delays more often than it is at delay inbetween.

By trying different combinations of Invert, Special EFX, and Sinusoidal, you should be able to create just 
the effect you want.    These three options give a lot of control over the flanging effect, so experiment with 
them all!

This function supports Presets.



Select Entire Wave
This will select the entire waveform from zero to the end of the wave.    It makes no difference if the view 
is zoomed in or not.    Double-clicking on the waveform selects the visible portion of the wave, while 
choosing Select Entire Wave (or pressing CTRL+A) will select the entire waveform independent of the 
portion being viewed.



Wave (Brainwave Synchronizer)
Audio may be Waved to produce files, that when listened to with stereo headphones, will put the listener 
into any desired state of awareness.    For example, by listening to waved files, you can easily achieve 
states such as deep sleep, theta meditation, or alpha relaxation.    Because of the nature of this function, it
only works on Stereo waveform data, and to be effective, must be listened to with stereo headphones.    
The Wave function spatially locates the audio left and right, in a circular pattern over time.    In order to 
spatially encode the signal, either the left or right channel is delayed so that the sounds will appear at 
each ear at different times, tricking the brain into thinking they are coming from either side.    When this is 
done at frequencies of 3Hz and above, the brain will start synchronizing at the same frequency, 
increasing its output of Delta, Theta, Alpha, or Beta frequencies.

LOW SETTINGS
These settings all correspond to the lower part of the graph.    If points are dragged to near the bottom of 
the graph, these settings will be active.

HIGH SETTINGS
And these settings correspond to points near the top of the graph.

Frequency Graph
Time is represented along the horizontal, so as you go to the right of the graph, you are setting the 
frequency characteristics of the highlighted sample later and later in time.    The settings chosen will vary 
between the low settings and high settings depending on where the graph dictates the signals should be.

Click on the graph to add new control points.    Drag a control point up or down, or off the screen to 
remove. Choose the highest and lowest frequencies that are represented on the graph with the scroll 
bars.    Gliding about 4 to 5 Hz over 2 minutes works nicely.    If large variations are done in short time 
spans, the effects are not as pronounced.    For example, after 5 minutes of Theta waves, if 30 seconds of
alpha waves are generated, and returned to theta, the listener will become slightly awake, and aware of 
his surroundings for that brief moment.    The effect is like all of the sudden changing gears, and you stop 
thinking about whatever it was you were thinking about, and become aware that you were thinking about 
it, but aren't any more.

Frequency
This is the brainwave frequency that will be encoded.    Different brainwave frequencies will stimulate the 
brain to sync to differing levels of consciousness (eg sleep, meditation, awakeness, etc.).    See the 
bottom of this article for more information on specific frequencies.

Intensity
This is the intensity of the brainwave encoding.    Higher intensities work well with lower brainwave 
frequencies.    Beta waves should have intensities below 25 or so, while Delta waves work better with 
intensities above 60.

Centering
You may choose to have your brain think the synchronization frequencies are coming from the left or 
right.    This may affect the left or right hemispheres more intensely, but that's only a guess.    Mixing a file 
that has been waved to the left with one that has been waved to the right (in the same frequency range 
within 2 Hz) has interesting effects.

Musical Source
If the selection being waved is musical, checking this will calculate the wave patterns in such a way as to 
eliminate clicks and pops.    If the source is noisy (waterfall, ocean, nature recordings, etc.) do NOT check 
this.    If you do, it will actually add interference. Since noise is based on "randomness", the clicks and 
pops are inaudible.

Smooth Wave



When checked, the actual audio appearing at the left and right channels is smoothed out, but the spatial 
encoding is identical.    The left and right channels will delay and un-delay following a smooth curve such 
that the delay difference between the left and right channels follows a sine wave, and the brain will hear 
the audio travelling around the head in a circe.    When Smooth Wave is not checked, the net delays are 
the same, but are achieved by holding one channel constant (at no delay) while the other channel is 
delayed following half a sine wave.    Then the other channel is delayed while the first is held constant.    
The boundary between holding constant and delaying is discontinuous in that the dD/dt (difference in 
delay over time) jumps from zero to a positive delay value without hitting any values inbetween.    When 
Smooth Wave is checked, the dD/dt is always continuous.    This will also cause less noticeable distortion 
in either channel when heard independently.

For special spatial panning effects, choose wave frequencies of 1Hz or less.    A mono source (left and 
right the same) will appear to move from left to right and back at period of 1/frequency.    For example, a 
frequency of 0.1Hz will pan the audio in a "full circle" over the period of 10 seconds.

Please read on for more information about Brainwave Synchronization Files



Channel Mixer 
On stereo waveforms, the channel mixer allows one to have total control over the left and right channels.   
The default values will leave the wave unchanged.    For mono waveforms, the wave is inverted (that is, 
crests become valleys, and valleys become crests).

New Left Channel
The slide bars give the percentage of each channel, left and right, that will go into the final wave after 
mixing.    Choosing an L of 0, and an R of 100 will make the left channel equal to the right channel.

New Right Channel
These two slide bars do the same, but for the right channel.

Invert
Choosing invert for either channel will invert the channel.    Peaks become valleys, and valleys become 
peaks.    By inverting both channels, there will be no perceived difference in sound when listened to.    But,
inverting only one channel will greatly change the sound when listened to.

This function supports Presets.

Vocal Cut Preset
This will sum the left channel with the inverse of the right, and place the result into both channels.    On 
music where the vocals are heard equally loud on both channels, the vocals will disappear, or come close
to disappearing.

By playing with the combinations, effects of swapping channels, creating a mono sounding wave that is 
equal to the left, right, or a mixture of both channels, and creating waves whose left channel is the inverse
of the right can be done.    



Invert 
This function simply inverts the samples, so all positive offsets are negative and all negative offsets are 
positive.    On stereo waveforms, both channels are inverted.



Compressor/Expander/Limiter/Noise Gate
The compressor function varies the output level based on the input level.    This allows one to expand or 
compress the dynamic range of a sample, limit the dynamic range so all audio is at roughly the same 
level, or create a noise gate where all audio below a certain level is clipped to zero.    This is all 
accomplished by use of a transfer function that is drawn using the graph.    The graph depicts input level 
along the x-axis (left and right) and the new output level along the y-axis (up and down).    A line from 
lower-left to upper-right (default) leaves the signal unchanged, since every input value goes to the exact 
matching output value.    Other weird transfer functions can be drawn as well, for example, boosting all 
input that has a level of around -20dB, and leaving everything else unchanged.    Or, drawing an inverse 
line (a line from upper-left to lower-right) will dramatically boost low amplitudes while dramatically 
supressing high amplitudes, that is, all quiet sounds are loud, and all loud sounds are quiet.

Invert
The invert button will change the graph to one that will function as the exact opposite.    For example, if a 
transfer function with a compressor characteristic is being displayed, pressing Invert will change the graph
to one with the corresponding expander characteristic.    For a graph to be invertable, it must have pointes
in the two corners (-100,-100 and 0,0) and it must be always increasing in output (ie,    you cannot go 
down in output volume as you go from left to right).      All segments must be sloping upwards from left to 
right.

Attack Time
Attack time determines the time it takes for the new output signal to reach the proper output volume.    If 
there is suddenly a quiet portion that drops 30dB, it will take this much time before the output actually 
drops to its corresponding volume level.    If the sum of Attack and Release times is too short (less than 
about 20 ms total), audable effects can be heard, such as a "vibrating" sound at a frequency of 
1000/<time>.    So if the Attack and Release times are each set to 5 ms (making 10 ms total), then a 
vibrating sound at 100Hz can be heard.    Thus, a total value of about 30 ms is about the lowest you can 
go without getting these effects.

Release Time
This is the time it takes the end of a previous output level to reach the proper output volume.    For 
example, where the Attack is the time it takes the start of a pulse to reach the desired output volume, the 
Release is the time it takes for the end of the puls to reach the desired level.

Samples/Group
The number of audio samples to group together into one volume level change.    A value of 1 is the best, 
so each sample gets it's own volume change.    Larger values will change that many samples together at 
a time.    You can go larger without noticeable changes in quality.    The only reason for using larger values
would be for speed, as larger values calculate much faster.    Use larger values for pre-viewing how a 
compressor is going to sound, then Undo, and use a value of 1 when the compressor is set just the way 
you want it.

Joint Channels
In Stereo, each channel can compress independantly, sometimes causing the surrounding background 
noise to get louder on one channel at a time, which may sound strange.    For example, a loud drum beat 
in the left channel will make the background noise sound louder in the right than in the left.    If Joint 
Channels is checked, both channels are used to find a single input dB value, and both channels are 
amplified the same amount, together.    For example, a loud drum beat on the left channel will cause the 
right channel to go quieter as well if compressing.

Compressors are used for the compression of the dynamic range of an audio signal.    It is generally an 
amplifier with two gain levels:    the gain is unity for input signal levels below a certain threshold, and less 
than unity for signals with levels above the threshold.    Compressors can be used to eliminate the 
variations in the peaks of an electric bass output signal by clamping them to a constant level, thus 



providing an even solid bass line.    To maintain the original character of the instrument it is necessary to 
use a compressor with a long A/R time compared to the natural decay rate of the electric bass.    
Compressors can also be useful to compensate for the wide variations in the signal level produced by a 
singer who moves frequently, changing the distance from the microphone.    Limiters are compressors 
with a compression ratio of 10:1 or greater because their output levels are essentially clamped to the 
threshold level.    A limiter can be used to clamp all audio to a prescribed output level, or just all audio 
above a certain threshold.

Expanders are used to expand the dynamic range of an audio signal, opposite of the compressor.    It can
also be considered an amplifier with two gain levels:    the gain is unity for input signal levels above a 
certain threshold, and less than unity for signals with levels below the threshold.    The expander is used 
to expand the dynamic range of an audio signal by boosting the high-level signals and attenuating the 
low-level signals.

Noise Gates are a special type of expander that can be used to reduce noise below a threshold level.    It 
attenuates heavily signals with levels below the threshold.    It is used to totally cut off the signal level 
during a musical pause so as not to pass the background noise present.    It can also be used to silence 
the pauses in speach.



Noise Generator
Generate random noise in a variety of colors.    Each color has its own characteristics. One use for 
generating noise is to create a waterfall-like sound which is ideal for Waving.    It is also great for making 
weird effects by flanging and equalizing.

Color
Noise can be a variety of colors, which describe its spectral composition.

Brown noise has a spectral frequency of 1/f^2.    Which means, in English, that there is much 
more low-end, low-frequency components to the noise, which results in thunder and waterfall like 
sounds.    Brown noise is called that because, when viewed, the wave follows a Brownian motion 
curve.    That is, the next sample in the waveform is equal to the previous sample, plus a small 
random amount.    This gives the appearance of a mountain range when graphed.    The wave 
pattern is very predictable.

Pink noise has a spectral frequency of 1/f and is found mostly in nature.    It is the most natural 
sounding of the noises.    By equalizing, rainfall, waterfalls, wind, rushing river, and other natural 
sounds can be generated.    Pink noise is exactly between brown and white noise (which is why 
some people used to call it tan noise, but pink was more appealing).    It is neither random, nor 
predictable.    It has a fractal like nature when viewed.    When zoomed in, the pattern looks 
identical to when zoomed out, except at a lower amplitude.

White noise has a spectral frequency of 1.    In other words, equal proportions of all frequencies 
are present.    Because the human ear is more succeptable to high frequencies, it sounds very 
"hissy".    White noise is generated by choosing random values for each sample.

Style
Noise can be generated in a variety of styles for your listening pleasure.

Spatial Stereo noise is noise generated by using 3 unique noise sources, and spatially encoding 
them to appear as if one is coming from the left, the other from the center, and the last from the 
right.    When listened to with stereo headphones, the mind perceives sound coming from all 
around, not just in the center.    To choose the distance from center of the left and right noise 
sources, you can enter a delay value in microsoeconds.    About 900 to 1000 microseconds 
corresponds to the maximum delay perceivable, and a delay of zero is identical to Mono noise 
(left and right channels are the same).

Independent Channels noise is generated by using 2 unique noise sources, one for each 
channel.    The left channel's noise is completely independent of the right channel's noise.

Mono noise is generated by using 1 noise source, with the left and right channels set equal to the
same noise source.

Inverse noise is generated by using 1 noise source as well, but this time with the left channel's 
noise exactly inverse of the right channel's noise.    When listened to with stereo headphones, the 
effect is that of the sound coming from the center of the listener's head instead of out in space 
somewhere.

Intensity
With higher intensities, the noise becomes more erratic, and sounds harsher and louder.

Duration
This is the number of seconds of noise to generate.    If long periods of noise are desired, it is faster to 
generate a short period of noise (about 10 to 20 seconds), delete excess noise at the beginning and 
ending of the noise so that the waves are starting and ending at the midpoint, copy, then loop paste as 
many times as needed.



If a selection range is highlighted, it is not replaced by the noise generated.    Noise gets inserted at the 
insertion point represented by the yellow arrows.



Cool Scripts
Scripts are similiar to Macros.    Your exact mouse moves, and tweaking of parameters is not stored, only 
the final result when you click "OK".    Undoing something is recorded into the script, since you may have 
copied something, then undid it, which can be a very useful technique.

Multiple scripts can be kept in one script file, and identified by name.    At any time, you can edit the script 
file directly to take out steps, rename scripts, remove unwanted scripts, etc.

There are various types of scripts, which depend on when you initiated the recording:
- Scripts that start with File->New, and always start with a blank, empty waveform.
- Scripts that start when a waveform is opened, and work at the current sample rate, etc.    Actions begin 
at the insertion point in the waveform, and may affect any part of the entire wave if present.
- Scripts that start with a highlighted waveform portion.    All actions in the script pertain only to the portion 
that is highlighted, leaving the rest of the waveform untouched.

Scripts that run during all of the above conditions will be displayed, but only the ones recorded under the 
same circumstances will be allowed to run.    In other words, if a script recording started when a portion of 
a wave was highlighted, then you will only be able to run that Script when something is highlighted.

Scripts are very useful for remembering how you generated a particular sound effect.    Use the script to 
reproduce the sound effect without having to save the entire waveform.    This is especially useful when 
generating large brainwave "theta" files, which can take monsterous amounts of space.    By generating 
the file once, with the scripting turned on (record), you can generate the file again at any time in the 
future, and save all that hard drive space.    You can also pass along scripts to your friends across email 
or BBS systems, since they take nearly no memory to store.

When running a script, you can either stop at each dialog box, or have the script automatically run 
through completion by using the "Stop at Dialogs" checkbox.    Stopping at each dialog box is handy if you
wish to 'tweak' the parameters while the script is running.

After recording a script, you may enter a description at the bottom of the dialog to go with the script you 
just recorded.    This description will appear when the user of the script highlightes the script to run.    Note:
the only time you can edit the description is after recording, not before, and not after it has been added to 
a script collection file.    But, you can still edit the description at any time by pressing the Edit button to edit
the text file directly.

A single script can be run on a batch of files by pressing the Batch Run button.    For more information, 
see Batch Processing.

Pause at Dialogs - At each dialog, the script will stop to allow you to modify the values to the function.    
Pressing Cancel at this point will stop the script, pressing OK will continue it.
Alert when complete - When the script is finished, a dialog box will signal the completion of the script if 
this option is checked.
Execute Relative to Cursor - When running a script that was recorded when a waveform was loaded but
there was no highlight, it can be run by playing back all the operations relative to the beginning of the file 
or to the beginning of the cursor.    For example, the Sound Effects scripts require you open a waveform (it
can be blank) first.    Checking this option will insert the effect at the cursor, otherwise the effect will be 
inserted at the start of the file.

Important Note:    Other buttons and functions are not disabled while the script is running.    Therefore, do 
not use the other functions until the script has stopped playing.

CONVERT.SCP Sample Collection
Description    These four sample rate conversion scripts are useful when you need to cleanly convert 



from one sample rate to another.    An FFT is performed to filter out high frequency noise, and the Stretch 
function is used to compress or expand the waveform while interpolating points that may lie between 
samples.
How To Use    Open a waveform with which you would like to convert the sample rate.    Run the 
appropriate script.    The following conversions are provided:    11K to 22K, 22K to 11K, 22K to 44K and 
44K to 22K.    Conversions work best if done on 16-bit audio.    If you are converting 8-bit audio, open the 
waveform as 16-bit first using the Open As command.    You can convert it back to 8-bit after the sample 
rate has been converted.

FXNS.SCP Sample Collection
Description    These are five sample functions I came up with.    Cross Fading is useful if you are going to 
loop the sample.    The last portion of the sample is overlapped with the first portion, and the amount of 
overlap is different for each Cross Fade script.    Full cross fading fades the last half of the sample with the
first half.    Soft cross fading fades the last 5% with the first 5%, and hard cross fading fades the first 0.4% 
with the last 0.4%.    Make Piano Keys will take the highlighted sample and stretch and compress them to 
vary the pitch, making 13 copies of the original, each at a different pitch.    Each pitch is assigned to a key 
on the keyboard through the cue list.    This turns your keyboard into a simple sample player.    Reverse 
Echo is just that -- the echo function, but the echoes go in reverse.
How To Use    These sample functions work on a highlighted selection.    Open a waveform, and highlight 
the portion you wish to operate on, then run the script.

SNDEFX.SCP Sample Collection
Description    Here are some nifty sound effects, and a small song (very small) I wrote.    If you run the 
Cool Song script, you can then go to the Music function, and enter a name for the song to save it under.    
This script generates a short note, and then uses the Music function to build the song.    The other four 
effects are just weird effects using the tones or noise functions with other transformations.    If you've 
watched "Dr. Who", you may recognize the Cool Lasers sound effect.
How To Use    These sound effects work in a currently opened waveform.    Open a New (blank) waveform
in any sample rate setting you desire for the quality you would like, and run a script.    These sound effects
can also be inserted into an existing waveform, and will be inserted just as if the Paste command were 
used.

MINDSYNC.SCP Sample Collection
Description    Included are four "Tones" synchronization scripts, which have a binaural beat pattern (two 
differing tones in each ear) overlaid with the corresponding "Waved" pink noise.    Choose Loop Play and 
listen to the audio as long as you like.    Each Tone script stimulates a different brainwave frequency, from 
Delta to Theta to Alpha, and an "Earth" tone of 7.83Hz.    The "Music" scripts have "Waved" music overlaid
with the pink noise for a relaxing effect.    The Creativity Theta Session is similiar to the sample theta 
session described with the Wave function, and lasts 1/2 hour.    The session starts at Alpha, goes down to 
Theta, and stays there with a few bursts into Alpha and back.

How To Use    Open a new blank waveform of any Stereo sample setting you wish.    I suggest using at 
minimum 22K 16-bit stereo, but the synchronization effects will still work at lower sample rates and 8-bit.   
Once you have a blank waveform to work with, run one of the scripts.



Batch Processing
A single script can be run repeatedly over a group of source files.    The script must have been recorded in
a "Works on Current Wave" mode, that is, before the script was recorded there must have been an open 
waveform (perhaps blank) and no highlighted selection.    The Batch Run button will only be selectable if 
a script of this type is selected from the Scripts list.

Any number of Source Files can be chosen as long as they are in the same directory (sorry about the 
limitation).    Press the Browse button to choose these wave files.    The wave files can also all be in 
different formats if desired.

After each file has had the script run on it, it will be saved to the Destination Directory.    You can choose
the Output File Format that all the waves will be saved as, as well as enter the appropriate options for 
the file format if the format supports options.

File names can be modified slightly before being saved.    The filename extension will change to that of 
the file format being saved automatically (eg *.AIF).    If another filename extension is desired, or some 
modification to the filename portion is desired, the filename template can be modified.    Use the question 
mar '?' to signify that a character does not change, and a '*' to denote the entire original file name or 
entire original file extension.    Here are some examples of how filenames will be saved given the original 
file name and the filename template:
zippy.aif *.wav zippy.wav
toads.pcm q*.voc qtoads.voc
funny.out b???????.* bunny.out
biglong.wav ????.wav bigl.wav
bart.wav *x.wav bartx.wav

Choosing Overwrite existing files will always perform the script on the file in question and save it to the 
destination, even if a file of the same name already exists at the destination.    If this box is unchecked, 
and the destination filename already exists, the batch will not even attempt to run the script on the file in 
question, but skip it instead.

In most cases, you can check the Disable Undo option to disable the Undo function during the batch run. 
Unless the batch was written expecting the Undo function to be enabled, this is a completely save thing to
do, and it speeds up processing because undo information does not continually need to be saved.

If a source file is unreadable, or in a RAW type format without any header information, then the batch 
needs to know what file format to assume for the data.    This ensures that the batch will run continuously 
without interruption by dialogs asking for input data formats on head-less data.



Customizable Toolbar
If you wish to re-arrange the toolbar buttons, or make certain buttons visible when the toolbar is shorter, 
you can do this by modifying your cool.ini file.    Cool.ini is located in your Windows directory.    In a section
of the INI called [Toolbar] you can define button order, and priority (which buttons get displayed first if 
there is not enough room for all buttons on the toolbar).    I appologize for there not being a visual way of 
re-arranging buttons at this point, but it will be possible in the near future.    Until then, you must edit 
cool.ini.

The easiest way to quickly get a button that you desire on the toolbar when you want it is to:

Swap the priority ratings of the button you want to see with a button you do not want to see.    For 
example, if the Paste button is more important than the Loop button, and Paste has priority 37, while Loop
has priority 10, then swap the priorities by giving Paste a priority of 10 and Loop a priority of 37.    This 
way, the Paste button will be displayed before the Loop button as the toolbar grows in length by resizing 
the application.

Positioning buttons is accomplished by changing the order in the list.    You will notice that each button has
an Item and Priority key associated with it.    For example, the Loop button has Item33=Loop and 
Priority33=10.    If you wanted to move this button to the left, give it a lower key value, such as 
Item9=Loop and Priority9=10.    When you do this, make sure that the original button associated with 
Item9 is changed as well, since there cannot be two keys of the same name.    The easiest thing to do is 
just to swap, and give the Item9 and Priority9 values to Item33 and Priority33.    For example, if 
Item9=Copy and Priority9=36, then you would change it to read Item33=Copy and Item33=36.    You could
also bump up all key numbers by one until you bump Item32 to Item 33.    (ie Item32... becomes Item33...,
Item31... becomes Item30... ,etc.).    Again, in the future, all this will be automatic and done visually by 
dragging and dropping the buttons.

If your toolbar becomes messed up, and you want it back to the original, just delete the entire [Toolbar] 
section along with all Item and Priority items, and Cool will re-build the section with the defaults.



About the Author
That's me, David Johnston.    I have been working with various sound programs since about 1991, and 
have been toying with electronic noise makers (synthesizers) since the 70's.    In high school I was even a
pseudo-member of the band with a home-made programmable "sequencer" that I used to make Pac-Man 
noises for the song Pac Man Fever.    I also started programming while in high school, when the school 
got a Commadore PET computer.    Shortly thereafter I bought an Atari 800 (summer 1992) and started 
my programming career.    I have since programmed on Apple ]['s, Commadore 64's, Macintoshes, IBM 
PC's (the original on up to today's), numerous mainframes and workstations.    I attended Eastern 
Montana College for my first two years, then moved to the Seattle area and got my BS in Computer 
Science and Engineering from the University of Washington in 1991.    I now work for a large software 
company, and write fun programs on my home PC when I get a chance.    This is one of them!    With the 
ShareWare donations I have been able to purchase a Pentium 90, so development on Cool Edit has 
thusly accelerated.    I gave my ol' 386-25 to my brother-in-law who is starting college.

I have also written a shareware kaleidoscope screen saver which is really cool!    It will even change 
patterns based on audio for your own personal "laser show".    Another useful utility I wrote was an RPN 
calculator for Windows which I use almost every day for one reason or another.    I've written other 
shareware programs too, so look for them at your favorite BBS or internet site.

I have tried to include all the wave editing features I have found useful, and am welcome to any 
suggestions for new waveform transformation functions, user interface, file formats (helps if you can 
provide a description of the new file format you want), and features.    The "wave" function in this program 
is quite unique and I hope you check it out.    It works only with stereo waveforms, and is the same 
function as in the freeware program out called MINDSYNC (wave.exe or wave87.exe) which I finished in 
July of 1992; see Wave for more details.    This program should be compatible with every sound card on 
the market that has Windows drivers available for it.    Please read the special notes in the Contents 
section If you have problems.

I hope you find lots of uses for Cool Edit, and find it fun and enoyable to use.    Feel free to let me know 
what you think of it.    It's because of input from numerous users out there that the program has evolved to
what it is today.

The Demonstration version of Cool has the following restrictions:
- There are no limits on length of files, time in use, or number of uses.- You have unlimited use of any of 
the functions, but may only use 2 groups of functions per editing session.

David Johnston
28022 NE 147th Place
Duvall, WA    98019
Internet: Davej67@aol.com

I consider US $25 a fair registration fee ($35 automatically gets you the next update, although I will 
always send an update if you just request it by mail).    And if you use this program a lot, I hope you 
consider registering it, even if you've never sent in money for a ShareWare program before.    It's quite 
easy, just write a check out to me and drop it in the mail.    When you register, you will be sent a 
registration number that will unlock the software, allowing unlimited use of all functions all the time.    If for 
any reason you do not believe the program is worth $25, send whatever you do think it's worth, and I'll 
send the password anyway.    Please include a reason why you don't think it's worth the asking price 
though.    If you would like a printed manual sent to you, write me a note asking for it and I'll send it down.  
It's free to all registered users.    Keep in mind that even though this product is Share-Ware now, it may 
not always be that way, and you may be asked to purchase the full retail product instead (that is, if there 
ever is a full retail product.)

For those of you overseas, send whatever you like, I will send you a password regardless of how much 



you send.    I have no way to do credit cards, so, unfortunately, the only way to send money is to send a 
cashier's check from your bank in US funds, or *cringe* cash in US dollars.    I know it can be quite 
expensive to exchange for US funds, so if you would like to send less because of the overhead, that's 
fine.    If you find it impossible to send any money at all, that's fine too--I'll still send you a password!

Please don't send any mail after Jan 1, 2001 as I don't know where I'll be living by then...    Until then, I'm 
sure I'll be at the above address.    If not, there will be a new version of this program out with the proper 
address information.

If you have the Demo version, and want to Register, click Register below.

REGISTRATION FORM



Cool Edit v.1.34 Registration Form
Name:    ________________________________________
Address: ________________________________________

________________________________________
________________________________________
________________________________________

City: _______________State/Prov: ____ Zip:________
Country (if not USA):    _________________

Internet Email: ________________________________________
Other Email: ________________________________________

Choose the level of registration you prefer:

[      ] $25**    Gets you the Registration Number only, no update disks sent.    

[      ] $35         Gets you the Registration Number, plus one major update on 3.5" disk.    ('major' 
means a new feature was added, or a significant number of bugs have been fixed).

[      ] $50         Same as $35, but if you really REALLY like the program, and know that it is worth 
more than $35, then you can send $50 if you want!    You'll most likely receive at least two 
updates as well, if not more!

I will gladly send updates (beyond the ones you already get with the registration level) for $10 per update. 
Please note the version you currently own so that I may send the next update.

**Special Note:    All the prices given above are just suggestions.    If you really feel the program is not worth $25, go 
ahead and send less, but please include an explanation of why you don't think it's worth as much, and I will still send 
you a Registration Number.

You may answer these if you like!    Just circle or fill in the blanks.

Where did you find Cool Edit?        ___________________________________________

Brand of PC: ______________________________________

Processor: 386SX 386DX 486SX 486DX Pentium Risc      
Other:_____________________

CoProcessor: x387 x487

Sound Card: ______________________________________

OS: Windows 3.1 Windows "4.0"     NT Other:_____________________

RAM:    __________        Hard Drive size: _____________

THANK YOU!!!!    AND PLEASE ALLOW A COUPLE OF WEEKS FOR A REPLY 

David Johnston
28022 NE 147th Place
Duvall, WA    98019





New Wave
When creating a new waveform, you must specify the waveform properties.    Using higher sampling 
rates, stereo, or higher bit resolutions will result in higher quality sounds at the expense of requiring more 
memory.

Sample Rate
The sample rate describes how many times per second to take a snapshot of the audio.    The human ear 
can perceive sounds up to about 17,000 cycles per second, or 17 Khz.    When choosing a sample rate, 
frequencies of up to 1/2 the sample rate can be produced effectively.    So to reproduce frequencies up to 
10Khz, a sample rate of at least 20Khz must be chosen.    Any sample rate may be entered in directly, or a
common sample rate can be chosen from the list.

8,000 Hz Telephone Quality
11,025 Hz Poor AM Radio Quality
16,000 Hz Reasonable compromize between 11K and 22K
22,050 Hz Near FM Radio Quality
32,075 Hz Better than FM Radio Quality (Some boards support 32,000 instead)
44,100 Hz CD Quality
48,000 Hz DAT Quality

Channels
Mono waveforms support one channel of audio information.    Stereo files take twice the space because 
there are two channels of information represented, a left and a right channel.

Resolution
This describes the number of bits to use for each sample on each channel.    Choosing 8-bit resolution will
provide 256 unique "volumes".    The PC-Speaker, for example, provides only 4-bits of resolution because 
it can support 16 unique volume levels.    Choosing 16-bit resolution will provide 65,536 unique "volumes",
for a 96 dB signal-to-noise ratio.    Much quieter sounds can be reproduced at 16-bit resolution than at 8-
bit resolution, which only has a 48 dB signal-to-noise ratio.    Compact disk players have a 16-bit 
resolution.

Note:    Certain combinations of sample rate, channels, and resolution may not be available on your 
system.    To see the maximum capabilities of your system, look at the status window when starting the 
program.    you may create and edit files that cannot be played on your system, you just may not be able 
to play them properly.



Adjust Sample Rate
You can change how Cool-Edit interprets the actual waveform data by adjusting any of the parameters 
below associated with the wave.    Be aware that listening to Mono data in Stereo format, or listening to 8-
bit data in 16-bit format will sound really really weird!

Adjusting the various parameters comes in very handy when loading in waveforms of unknown type 
(RAW).    You can play with the various settings until the wave sounds "right".

Sample Rate
This describes how many times per second to take a snapshot of the audio.    The human ear can 
perceive sounds up to about 17,000 cycles per second, or 17 Khz.    When choosing a sample rate, 
frequencies of up to 1/2 the sample rate can be produced effectively.    So to reproduce frequencies up to 
10Khz, a sample rate of at least 20Khz must be chosen.    Choose Custom to enter a sample rate not 
listed.

Channels
Mono waveforms support one channel of audio information.    Stereo files take twice the space because 
there are two channels of information represented, a left and a right channel.

Resolution
This describes the number of bits to use for each sample on each channel.    Choosing 8-bit resolution will
provide 256 unique "volumes".    The PC-Speaker, for example, provides only 4-bits of resolution because 
it can support 16 unique volume levels.    Choosing 16-bit resolution will provide 65,536 unique "volumes",
for a much higher signal-to-noise ratio.    Much quieter sounds can be reproduced at 16-bit resolution than
at 8-bit resolution.    Compact disk players have a 16-bit resolution.

If you wish to convert your current sample to a new sample rate, please read about Converting Sample 
Rates for the correct procedure.

Note:    Certain combinations of sample rate, channels, and resolution may not be available on your 
system.    To see the maximum capabilities of your system, look at the status window when starting the 
program.    you may create and edit files that cannot be played on your system, you just may not be able 
to play them properly.



Byte Swapping
You can change how Cool-Edit interprets the actual waveform data by swapping high and low order bytes
in 16-bit mode, or by adjusting the signed/unsigned interpretation of bytes in 8-bit mode.    Swapping the 
byte ordering comes in very handy when loading in waveforms of unknown type (raw PCM).    You can try 
swapping the bytes if the waveform does not sound correct.



Paste Special
Waves from the clipboard can be looped, or mixed the current waves.    They are inserted or overlapped 
starting at the current insertion point.

Volume
Use the volume slides to paste an amplified version of the clipboard wave into the current waveform.    By 
adjusting the volume slides, single channels may be pasted.

Invert
Choosing Invert will invert the data being pasted before pasting.    This is very handy in taking the 
difference between two samples.    For example, after filtering, one can hear the audio that was filtered by 
Copying the selection, choosing Undo, then Paste Special with Invert checked.    After auditioning, the 
original sample can be pasted back by just choosing Paste.

Lock left/Right
When checked, the volume slide bars are locked, so both left and right volumes can be adjusted at the 
same time.

Overlap
When overlap is checked, the clipboard wave does not replace the currently highlighted selection, but is 
mixed at the selected volume with the current wave.    If the clipboard wave is longer than the amount 
selected, the wave continues being pasted beyond the selection.

Modulate
When modulate is checked, the clipboard wave is modulated with the current wave.    This is like 
overlapping, excpet that the values of the source wave and clipboard wave are multiplied by each other 
sample by sample, instead of added.    To quickly modulate by a sine wave, use the Generate Tones 
function which has a "Modulate by Source" option.

Loop Paste
When checked, the clipboard wave is pasted the number of times entered.

If the format of the waveform data in the clipboard differs from the format it is being pasted into, it will be 
converted accordingly before pasting occurs.

From Clipboard
When chosen, the audio data to be pasted is the data currently on the clipboard.

From File
When chosen, a file may be chosen with Select File to be pasted.    This is especially useful when the 
amount of data you wish to paste is too large for the clipboard.    If this is the case, use Save Selection to 
save out the highlighted selection to a file using a non-compressed file format.    Then by using this option 
the data from the file can be pasted.



3D Echo Chamber
This function will calculate the actual echoes as if the source audio (highlighted selection) and 
microphones (destination channels for echoed wave) were in a room of any given size and with walls of 
any given dampening factors.    The number of echoes to calculate is adjustable, up to about 5,000 
echoes.    The more echoes there are to calculate, the longer it will take the function to complete.    
Practically any "ambiance" setting can be created using this function.

One great use for this function is to convert Mono audio to Stereo with all the right ambiance.    Choosing 
a "left" microphone that is one to two feet away from the "right" microphone will simulate the ears of a 
listener, and will give the effect of "being there" when listened to with stereo headphones.    Be sure to 
copy the mono audio into a stereo format before performing the echo so you can choose two separate 
microphone locations.    A spatial stereo expansion effect can be created by placing the two microphone 
locations far apart, further apart in the settings than you will be playing them through speakers in real life.  
For example, if your stereo speakers are 6 feet apart, try placing the left and right microphones 20 or 30 
feet apart in the settings.

To give more control over the environment, dampening factors can be applied to any of the 4 walls, floor, 
and ceiling.    If a wall has a dampening factor of    1.0, it is totally reflective (like cement).    If a wall has a 
very low dampening factor, like 0.05, it will absorb most of the sound (like carpeting or sound proofing 
panels).    You can also lower the dampening factor of some of the walls to simulate the fact that other 
objects in the room are absorbing some of the audio.

Always place the microphone(s) sufficiently far from the source.    If the microphone and source are too 
close together, you will just hear the source and no echoes since it is analgous to placing your ear right 
next to the sound source where you hear the sound only (which is very loud) and nothing else.

Room Size
The length, width, and height of the room can be entered in units of feet (sorry, no metrics this time...    
There are approximately 0.3 meters per foot for those who need to convert).    When entering source and 
microphone locations, they must lie between zero and the room's width for the "Distance from Left" 
parameter, and zero and length for the "Distance from Back" parameter.    Room sizes can be as large as 
memory will allow.

Intensity
The volume of the echoes is determined by the volume of the first (direct) audio.    The direct sound that 
reaches the microphone from the source will be at the same amplitude as the original audio being 
echoed.    Thus, in a room of any size, if all 6 dampening factors are set to zero, there will be no change 
when echoing.    Every echo adds to the amplitude of the finished audio, so the intensity should be set to 
less than 100%.    In fact, the more echoes there are, the lower this value should be set to prevent 
clipping.    In general, about 1% less for every echo, down to a reasonable limit of about 5% for 100 
echoes or more (since after a while, the echoes are so quiet, they don't add to the final amplitude of the 
audio).

Echoes
This is the number of actual echoes to produce.    To get a nice reverb and ambiance effect, at least 30 
echoes should be generated.    The more echoes that are generated, the truer the result will sound.    You 
must sacrifice the quality you desire with the time you are willing to wait for the final product.    Generate 
about 15 echoes or so to test the chamber size and general room sound, then increas that dramatically 
for the final production.    Up to 4,000 echoes can be generated for the very very patient.

Damping Factors
Use the damping factors to set the type of room in which the audio is being played.    The factors can 
simulate wall coverings, floor coverings, and other objects in the room that absorb sound.    Granted, in 
real life, various objects absorb different frequencies of audio.    In this simulation, all frequencies are 



reflected equally.    The effects of speaker placement enhancing or cancelling certain frequencies, though, 
is still accurate.    The fact that cement reflects high frequencies better than low ones is not accounted for, 
but great effects can still be achieved, and these effects are much more realistic than the basic Echo 
function.    A damping factor of 1.0 is the greatest, simulating total reflectivity.    A factor of 0.0 is the lowest,
for total sound absorbtion by the reflecting surface.    If enough people want the walls to absorb various 
frequencies, and not just all frequencies, I can add the parameters if enough people want it.

Source Signal Placement
The source (highlighted audio before running this function) can be placed anywhere in the room. The 
audio is simulated as a point source of audio, not directional.    This means the audio will radiate outwards
in all directions from the source, and not more in one direction than another.    Directional audio would 
require a handful of new parameters and if this is desired, I can add it in if enough people say they want it.
The distance the source is placed to any of the walls will affect the frequencies that are enhanced.    In 
otherwords, source signal placement is crucial to the ambiance effect that is gained with this function.    
With stereo source, each channel can be placed independent of each other.

Microphone Placement
There can be up to two virtual microphones.    Each microphone represents a destination audio track.    
The audio placed back into the waveform (the result of the echoing) is exactly what the microphone would
hear if it were in the room at the location specified.    Stereo signals have two pick up microphones while 
mono signals have only one, since there is only one channel in which to place the result.    Placing the 
microphones in a stereo setting one foot apart will simulate the ears, and when listened to with stereo 
headphones, will sound as if you were actually in the room (if enough echoes are generated).    The brain 
will be able to pick out the directions of each echo, as well as the fact that the delays of the echoes will 
give the brain cues as to the size of the room.    Placing the microphones very far apart and listening with 
headphones will give a very large "aural" or "Spacy" feeling to the audio, like it is all around you and 
inside you.    Don't place the microphones too close to the source, otherwise the relative volume of the 
echoes will be so low that they will not be able to be heard.

Mix Left and Right into Single Source
When working with stereo audio, there are actually two source signals, one for each channel that can be 
placed independently.    This takes twice as many calculations as a single audio source, so this option 
allows you to mix the left and right into a single point source for faster calculations.

Experiment with various settings to get the reverb you desire.    Some presets are available, but a big part 
depends on the type of source audio that is being echoed.



Distortion
Use this function to map any sample value to any new sample value.    Effects such as blown car speaker,
muffled microphone, overdriven amp, cranked car stereo and many more can be created.

The horizontal axis represents the input sample value in dB, while the vertical axis represents the output 
sample value in dB.

Have fun making your audio sound really really BAD!    (Of course, it's great for adding fuzz to guitar licks 
to get that heavy metal sound).



Normalize
Normalize will amplify the highlighted selection so it is the desired percentage of maximum.    Optionally, a
DC Bias can be set.    Setting a DC Bias to zero will ensure that the waveform is centered on the zero 
voltage line.

Use this normalize function if you are recording a script in which you want to normalize a waveform to a 
specific percentage of maximum.    After normalizing to a specified level, pressing the F3 key will 
automatically run Normalize again on another waveform for very fast normalization of waves.



Convert Sample Type
This function converts the sample type "in place" by directly converting the types of the samples in the 
temporary file that represents the current waveform.    Various levels of quality can be chosen, as well as 
general volume levels when converting between mono and stereo formats.    The High quality settings are
slower, but the quality far surpasses that of the quicker Low quality setting in sample rate conversion.

When downsampling (converting to a lower sample rate), the High Quality setting performs a brick wall 
low pass filter at just below the Nyquist (1/2 the lower sample rate) frequency.    Optional emphasis can 
be performed when downsampling to try and regain some of the high frequency energy that was lost 
because of the brick wall filter.    In fact, an emphasis of about 3dB per sample-rate-halve or sample-rate-
double is recommended due to the loss of high frequency incurred by the compression algorithm.    For 
example, when downsampling 44.1K to 22K, use a 3dB emphasis minimum.    If downsampling 48K to 
11K, use a 6dB emphasis minimum.    The frequencies just below the Nyquist are amplified the number of 
decibels entered, and quickly, but very smoothly, taper off to no amplification by the lowest frequencies.     
Choose higher levels of emphasis than the recommended minimum when downsampling    to brighten the 
highs, which should help compensate for the loss in high frequency due to the lower sample rate.    Using 
high quality will very cleanly convert between non-standard sample rates as well (eg 44.1K to 16K, or 32K
to 11K) with minimal aliasing effects in the very high frequencies.

The Low Quality setting just does a straight linear interpolation of data points which introduces some 
high frequency noise when upsampling, or aliasing when downsampling.

When converting from Mono to Stereo, you can choose the amplification levels for both channels 
independently, with 100% for both channels being the default.    You can choose a value of -100% for one 
of the channels to get an "inverse mono" effect, where the left channel is the inverse of the right.    When 
converting from Stereo to Mono, you can choose the amplification values for each channel before they 
are combined.    Values of 50% for both channels is the default, meaning that the resultant mono 
waveform has (l+r)/2 signal, or the average of the two channels.    You can even choose a negative value 
for one of the channels to perform a vocal cut effect on some audio.

When converting from 16-bit resolution to 8-bit, you can optionally add some dither in the audio to make 
sounds still audible that are quieter than the limit that 8-bit audio provides.    To do this, a small amount of 
noise is added to the signal, but quieter audio can be heard in the noise.    If dither is not checked, quiet 
audio will just fade in and out, with a more disruptive choppiness sound that resembles rain falling, or 
static.    Whether or not dithering is used depends on the audio being converted, and your preferences.

Warning: This is one of the few functions that is not undoable!    Please do not interrupt the progress by 
pressing Cancel.



Noise Reduction
Background noise and general broad band noise can be dramatically reduced with minimal reduction in 
signal quality.    The amount of noise reduction depends upon the type of background noise, and the 
allowable loss in the quality of the signal that is to be kept.    In general, increases in Signal to Noise ratios
of 5dB to 20dB can be achieved (noise is reduced 21dB and signal 1dB for example).

Two steps are required to remove noise.    First, the noise level must be set so the filter knows what type 
of "noise" to remove.    To do this, highlight a section of the waveform that has no important signal in it, 
and only has background noise, then press Set Noise Level.    The statistical information about the 
background noise is then gathered, and you are set to remove all noise of this type from your waveform.

Once the statistical data is gathered, the second step is to highlight the section you want to remove the 
noise from, and choose the level of reduction you desire.    A level of zero will remove the least amount of 
noise, and nearly no signal loss will occur.    Typically the noise will be reduced about 3dB at this level.    A 
level of 100 will remove the maximum amount of noise, lowering the noise level by about 20dB.    If the 
signal you are trying to keep gets too distorted at this level, use lower values until a balance is reached 
between noise reduction and allowable signal distortion.    Values any higher than 100 will guarantee loss 
of the signal that you want to retain, but this may be desired if reducing noise is more important than 
retaining original signal.

Distortion effects may manifest themselves a "hollow" or "underwater/burbly" sounding signal, dull 
sounding impacts, "rolly" high end, or a "computerish" mechanical sound.    These effects, if heard at all, 
will fall off if the noise reduction level is reduced.    The amount and type distortion depends on the type of 
noise that is being filtered.

Besides reducing the noise level, the type of noise that is present after reduction is entirely different than 
the type of noise beforehand.    For example, if you are trying to get rid some "tape hiss" from a waveform,
the tape hiss sound will completely disappear, and in it's place about 15dB quieter will be completely 
different type of noise.    This noise will contain all frequencies in different combinations, thus it cannot be 
reduced much further without noticeable signal loss.    The new noise has a "burbly" or "bubbly" quality to 
it, and if amplified, sounds very harmonic--like those 1960's computers in old science fiction films.    Since 
this is so much quieter than the original noise though, it is very acceptable.

Great effects can be generated by setting the noise level to some valid signal component in the 
waveform, and not the background noise.    Whatever frequencies are present in the highlighted selection 
when Set Noise Level is chosen will be removed when the reduction level is set to 100.

Use this function to remove tape hiss, microphone background noise, 60 cycle hum, or any noise that is 
constant throughout the duration of your waveform.    You can even reudce the noise incurred by the 
sound board's circuitry during recording--just record a second of silence before whatever you want to 
record and tell the noise reducer to remove the sound of that silence for another 10dB dynamic range.

Save Profile
Once the noise level is set, you can save the noise profile in a *.fft file.    This file will contain information 
on sample type, fft size, and three sets of fft coefficients, one for the lowest amount of noise found, one 
for the highest amount, and one for the power average.

Load Profile
Loads any previously saved noise profile.    You can load any *.fft file that Cool Edit has saved.    
Eventually the spectrum analyzer and Filter functions will support *.fft files.    A noise profile is only 
compatible if it is being used on a sample of the same type when the profile was saved.    In other words, 
a 44K stereo 8-bit sample is not compatible with a 22K mono 16-bit profile.    Also, since noise profiles are 
so specific to the recording environment of waveform in question, even if the sample types are 
compatible, a profile for one type of noise will not work on another type.    Even if the audio samples were 



recorded with the same microphone, if the recording environment is different, the type of background 
noise could be different.

FFT and STATISTICAL SAMPLING settings
These settings will affect the noise reduction quality, and the type of distortion heard when reducing the 
noise.    Try different settings to get the best noise reduction while keeping the intended signal in tact.    
The FFT Size parameter causes the most drastic changes in quality.    Good settings for the size are 
2048. 4096, and 8192.    The FFT Precision Factor affects distortions in amplitude.    With values of 3 or 
less, the FFT is performed in giant blocks that are not very continuous between the blocks.    This means 
after each block is processed, there can be a drop or spike in volume at the interval between blocks.    
Values of 5 and up work best.    On past about 15, there is no noticeable change in quality - just the time it
takes to compute.    I like to use 5 or 7 (and I think odd numbers are best for symmetric properties).    The 
Number of Samples can be chosen for the gathering of statistical data.    This number describes how 
many snapshots of noise to take in the highlighted interval when Set Noise Level is pressed.    The larger 
this number, the more accurate the statistical data is.    A value of 64 is plenty.    You will notice that using 
very small numbers of statistical samples will greatly affect the quality of the various noise reduction 
levels.    With more samples, a noise reduction level of 100 will most likely cut out more noise, but also cut
out more original signal too.    But, with more samples, a low noise reduction level will also cut out more 
noise, but most likely not disrupt the intended signal.

Special Notes
Noise reduction works best on 16-bit samples, although it will work perfectly on 8-bit samples.    Because 
of the nature of 8-bit audio, it is impossible to get the noise level to less than about -45dB if even that.    
Noise at -45dB is very audible, as owners of 8-bit sound cards can attest.    Converting to 16-bit first, then 
reducing the noise will produce a sample with much less noise than can be done in 8-bit alone.

The noise reduction works best if the original signal is centered.    To center a signal, highlight it and 
choose "Center Wave" from the Amplify function.    Centering the wave adjusts the DC offset to zero.    If 
the wave is not centered, audible clicking may be heard in really quiet situations.    Since centering takes 
out all frequencies below about 16Hz, it is completely safe to do without any ill side effects.



About Carrier Waves
A carrier wave is needed to transport the brainwave frequencies.    Because the carrier wave is not what 
you hear through the headphones directly, you do not need to buy super high-end headphones (5Hz-
25KHz) to reproduce the effects.    In other words, your headphones do not need to be able to reproduce 
a 5Hz signal if you are generating a 5Hz theta-frequency brainwave file.    The brain does however 
respond better to the lower frequencies, so the better the headphones you buy, the more dramatic the 
results will be.    The best headphones are the kind that cover the entire ear, so outside noise does not get
in.    Plus, these headphones have much higher response to low frequencies.

Carrier waves must have some correlation between the left and right channels, no matter how slight.    So 
mono (total correlation), inverse (total negative correlation), and spatial (natural recordings that have 
some of the same sounds coming in both channels) will work great.

The best sounds to use as carriers are sounds that are spread across the entire frequency range, or at 
least most of the lower frequency range.    Good examples are ocean, waterfall (most any recordings from
nature), and noise generated by this program.    Experiment with mono (both left and right channels the 
same), inverted (like mono, but the left channel is the inverse of the right, obtained by using the Channel 
Mixer), and spatial stereo (spatially encoded sounds in nature, recorded with microphones about 9 inches
apart to simulate separation between the ears).    But don't let this stop you from digitizing your favorite 
music, and using it as a carrier, or converting your favorite to a mono or inverted wave.

To generate a carrier wave, you can do three things:

Record a sample    Once recorded, use the Channel Mixer to create a mono, or inversed wave.    Or just 
leave it the way it was recorded.    You may find changes in effectiveness of the brainwave files depending
on how you use the Channel Mixer.    Keep in mind that this function only operates on stereo waves, so 
when "mono" is mentioned, it means that the exact same signal is present on both channels--the left 
channel and right channel are the same.

Generate Tones    You may use the Generate Tones function to find a pleasing, relaxing tone for the 
background (but I find "noise" sounds more relaxing).    The way tones work the best is if the left channel's
tone frequency is 5-6 Hz different from the right channel's tone.    This creates a beat pattern equal to the 
frequency difference, which the brain responds to somewhat (this is the property that many theta-inducers
rely on).    To do this, generate one tone with left volume at 40, and right volume at zero.    Then generate 
the second tone with the left and right volumes reversed.    Finally, Paste Special (with overlap) one tone 
on top of the other.    Use low frequency tones, like 50Hz to 120Hz for best results.    These tones, by 
themselves, will help coerce the mind into the state associated with the difference between the 
frequencies.    For example, for a theta state of 6Hz, use a 70Hz and a 76Hz tone.    Combining this tones 
sample with an existing brainwave file, by overlap pasting at a quiet volume (20%) is even more effective.

Generate Noise    Use the Generate Noise function (pink and brown work best) in any of the modes: 
mono, inverse, or spatial stereo (independent channels noise will not work as a carrier for brainwave 
frequencies at all, since there is no correlation between the left and right channels).    I find that using pink 
noise in spatial stereo, and running it through the Quick Filter to get rid off some of the "edge" if any works
the best.    I have also found Inverse to work quite well too, but the brainwave "effect" is more pronounced,
and can be distracting, and some sound boards have trouble reproducing sound that is inversed between 
channels.

Once you have found a pleasing sound, about 10 seconds or so of a monotonous sound (tones, river, 
waterfall, noise...) you're ready to start.    If a monotonous sound is used, more disk space can be saved 
because we will use the play list to repeat portions.    If a music sample were used, it is quite noticeable 
that the same 10-second piece is being played over and over and over again.

If you're curious you can also spatially locate a mono sound to the left or right?.    Do this if you wish to 



have the illusion that a particular sound is coming from one side or the other.    The function works by 
pasting a mono sound sample into a stereo waveform, and using the Digital Delay function.    Having a 
quiet "ping" (generated by using the sine wave tone generator with the bell curve envelope) play spatially 
on the left, then on the right at about 5 second intervals is very relaxing.



Encoding Brainwave Information
There are two types of brainwave files that you can create:    A flat file, and a cued file.    The flat file 
takes more memory, and plays straight through from beginning to end, while the cued file is actually 
contains pieces of the entire audio program, that when played in the proper order become the brainwave 
file.    The cued file takes less memory, and can very quickly be modified at any time by re-arranging the 
audio pieces.    The average length of a cued file is about 3-4 minutes for a program that can last as long 
as desired.    The flat file is a standard wave file, which means to create a long program, you must have 
enough space for it.    The only advantage to using a flat file is if you are waving music, since music 
cannot be split into pieces and re-arranged, otherwise it would sound discontinuous.    Creating brainwave
files using the flat file method will be discussed first, since it is more straightforward

Flat Brainwave File Generation    Create a file the length you wish to make your relaxation program 
using the carrier wave(s) of your choice.    Either record music, or use the pink noise generator and copy 
and paste (or Paste Special) to the desired length.    If you are using a monotonous sound, you would be 
better off using the cued file method.    Lengths of good relaxation programs vary from 15 to 30 minutes, 
and beyond.    This means you must have enough hard drive space for the entire file.    Since the 
temporary file takes up hard drive space as well, the maximum size of file you can create, and be able to 
save, will be one that takes up half of the initial free hard drive space.

Use the Wave function to encode the brainwave patterns into the carrier wave by highlighting a section of 
the wave, or the whole thing, and choosing Transform:Wave, or click the wave icon.    With the wave 
transformation, you have complete control over the brainwave frequency being encoded, the strength of 
the signal, and the positioning of the signal left or right.    Over the selection highlighted, the intensity, and 
position remain constant, but the frequency can be varied using the graphical input control.    See the 
section on Authoring Brainwave Files to learn what settings to use for the Wave function, and how to build
effective files.

Once the entire file has been waved to your satisfaction, you can save the file if you wish, and play it 
using the Play button.    An interesting side effect is that different sounds are heard if you listen to one 
channel, listen to both channels with one ear, or listen to each channel with each ear.

Cued Brainwave File Generation    These files contain many short snippets of brainwave encodings at 
different frequencies.    Each snippet is cued using the Cue List, and a Play List is generated by adding 
entries from the Cue List, and looping them if necessary.    To listen to a cued brainwave file, you must use
the Play button in the Play List dialog box.

First you must figure out how you want to divide up the brainwave program (your 20-30 minute 
masterpiece) into components.    For example, you may want to have patterns of 5Hz, 7Hz, and 9Hz at 
different points in the program.    In this case, you will need at least three pieces for your creation.    The 
actual file will just be 10 seconds of carrier wave at 5Hz, followed by 10 seconds at 7hz, followed by 10 
seconds at 9Hz.    All the pieces are placed in the cue list by highlighting the piece, and choosing Add.    It 
is best to add the piece to the cue list once it is created, or pasted at the end of the current waveform.    To
create the final program, the pieces are added to the Play List in the order you wish to listen to them.    
Each piece can be looped if needed.    So a 20 minute program can be generated from 3 10-second 
pieces by adding the cues to the play list and looping.

First you need to create 10 to 20 seconds of carrier wave, and save in a special file in case you need the 
carrier wave again later.    Highlight the wave, and Edit:Copy.    When you need another copy of the initial 
carrier wave, you need only to Paste it.

Add the first carrier wave snippet to the Cue List by pressing the Add button in the Cue List dialog.    Give 
the cue for this snippet a name that reflects the waveform transformation you will be using, for example, 
"6Hz to 5Hz drop".



Choose the Transform:Wave function to encode the proper patterns into the carrier wave.    Look at the 
section on Authoring Brainwave Files to learn what settings to choose.

Click past the end of the wave file (make sure the rightmost part of the file is in view), and choose Paste 
to insert another copy of the carrier wave.    Once you do this, you can add the newly inserted selection to 
the cue list, and give it a name.    Repeat the step above for creating a brainwave encoding over the 
carrier wave you just inserted.    Do this as many times as needed until you have all the pieces you need 
to build the final brainwave file.

Once all the pieces have been generated, add them in the order you like to the play list.    To make pieces 
last longer (if the beginning and ending of the piece are at the same brainwave frequency), increase the 
number of loops for that entry in the play list.

When Played from the play list, the pieces will be played in the order shown, and looped if necessary.

To get familiar with the cue list, and play list, open one of your favorite wave files, and highlight sections 
then add them to the cue list.    After you have a few selections in the cue list, add them to the play list, 
and choose a loop count of greater than one for some of them.    Choose Play from the play list, and listen
to what you've just created.



Authoring Brainwave Files
After learning about carrier waves, and encoding procedures, all you need to know is what frequencies to 
use, and when to use them during the course of the listening session.    Once you know what frequencies 
to use, and at what intensity, you can generate the completed file using either of the methods above.

Effective brainwave files have some sort of encoding going on the entire length of the session.    For the 
first 3 minutes or so of the session, the listener will not be in a "relaxed" state, and will not respond greatly
to the frequencies being presented.    During this warm-up period, gradually decreasing from about 12Hz 
down to 8Hz works nicely.    After about 4 minutes, the listener's brainwave patterns will start to 
synchronize with the patterns in the headphones, and the serious brainwave programming can begin.

Frequencies of 8-10Hz correspond to an alpha state -- light relaxation, like a quick afternoon siesta.    
Frequencies of 6-7Hz correspond to a theta state -- meditation.    4-5Hz correspond to deep relaxation.    
You can create a session that is constant, in one of these states, or create a session that dynamically 
flows from one to the other.    When going down in frequency, give the listener about one minute to "catch 
up", and stay in sync with the wave.    Going up in frequency does not require the listener to catch up.    In 
other words, if you go from 6Hz down to 4Hz over a 20 second timespan, and hold at 4Hz, the listener 
may not be at 4Hz for another minute.    When going from 4Hz to 8Hz in 20 seconds, the listener will be at
8Hz at the end of the 20 seconds.    It appears to take extra time when going down in frequency, but no 
extra time when going up.    This basically holds true for the first 20-30 minutes of a session.    After that, 
the opposite tends to occur.    It is easier to go lower than go higher.    This means that to bring a listener 
from 4Hz (where she has been for the last 30 minutes) up to 12 Hz, it should be done over a 5 minute 
period or so.    One nice "trick" to do is to keep the listener at around 4-5 Hz for a while, then about once 
every 2 minutes, go up to 8Hz and back over a 20 second span.    This will alert the listener slightly, and 
make them aware for a few seconds of what they are thinking.    This is great for getting creative insights 
and the like.    It acts as a sort of window to the subconscious, allowing one to remember what is going on.
It's kind of like remembering dreams:    you do it better if you are awaken in the middle of one.

Another effective method of producing relaxation files is to overlap them.    That is, have portions that are 
one frequency, and slightly spatially located to one side overlapped with a slightly differing frequency 
spatially located slightly to the other side.    This gives the listener the chance to decide which frequency 
to be at, and gives them more freedom over the experience.    For example, a session could go from 8Hz 
to 4Hz over 10 minutes overlapped with 7Hz to 5Hz over the same 10 minutes.

For nice super-relaxing effects, generate panning waves (frequencies of 0.05 to 0.2) over your session 
after encoding the initial brainwave patterns.    For example, if you are generating a brainwave file out of 
20-second pieces, after generating the main brainwave frequency over the 20 second period, generate a 
panning wave of 0.05 or 0.1 (which means a period of 20 or 10 seconds) with an intensity of about 50 or 
so.    This will make the sound appear to shift left and right to the listener over a 20 or 10 second period.    
Now, overlapping a 24-second piece panned at 0.125 (8 second period) at 5Hz with a 0.167 (6 second 
period) at 6Hz will combine the practices of multiple frequencies with panning for an extremely super-
natural effect!

Once you get started creating a few files, and see what the different frequency ranges do, you will 
become familiar with the different effects and how to generate just the effects you want.

Gamma frequencies of 200Hz or more seem help in relaxation, and do something I'm sure, but I don't 
know what... yet.    This is an area you can experiment with.    When generating frequencies above 40Hz 
or so, it is best to keep the intensity very low, like 7 or 8.    The higher the frequency, the lower the 
intensity has to be, otherwise the encoding will overwrite itself and the signal will be lost.



Sample Theta File - Step-by-Step
1 Create a new blank file with File:New.    Choose a Stereo file, either 8 or 16 bit and a 11025, 22050, 

or 44100 sampling rate.    The final file size will be one of the following sizes listed below depending 
on your choice:

         11025 22050 44100 
8-bit 2.6M 5.2M 10.5M
16-bit 5.2M 10.5M 21.2M

You must make sure you have enough memory for a file of this size, plus an additional meg for 
working space.    If you plan on saving the file when you are done, you must have at least twice this 
amount of hard drive space available, since a temporary file is used instead of memory while working 
on the wave.

2 Choose Generate:Noise.    Choose Pink Spatial Stereo for 15 seconds at an intensity of 3.    This is 
usually the longest portion of the generation of brainwave files.    Because of this, it is advised that you
save this piece of noise so that in generating future files, you can just load in this pre-calculated noise
as a starting point.

3 Choose Edit:Copy.    From now on, we will paste the noise in when we need it!

4 Make sure the noise is highlighted.    If it is not, select all by double-clicking on the waveform until it is 
highlighted.

5 Choose Add in the Cue list, and give the entry a Label of 10Hz to 8Hz, and a Description of Warm-
Up.

6 Choose Transform:Wave to bring up the brainwave dialog box.    Enter 10 for the Highest 
Frequency, and 8 for the Lowest Frequency, and an Intensity of 35. On the graph above, click the 
leftmost dot, and drag it to the top of the graph.    Click the rightmost dot, and drag it to the bottom of 
the graph.    This will product a frequency encoded at 10Hz at the beginning, and glide down to 8Hz 
by the end.    Choose OK to generate the encoding.    This shouldn't take nearly as long as it did to 
generate the noise.

7 Click the mouse at the rightmost portion of the wave (just beyond the black waveform display area).    
When you do this, the yellow cursor arrows should be all the way to the right of the wave. You must 
always add new pattern blocks at the end of the current waveform.

8 Choose Edit:Paste to insert another copy of the original noise that we had copied originally.

9 Create the following pattern blocks as before (following the steps 5 to 8) , except with the following 
values for the cue list and waveform transformation:

Label      Description Hi Freq. Lo Freq. Intensity 
8 Hz        Alpha                  8                8                    37 
8 to 6Hz Glide Down 8          6                  38 
6Hz          High Theta    6            6                    40      
6 to 5Hz Deeper Theta 6            5        45    
5Hz          Theta        5                5          50        
5-8-5      Spike      8          5          50    
                                          (Graph should look like an upside-down "V")
5 to 12Hz Awake 12    5    40    
                                        (Graph should go from left=lowest to right=highest)



10 Once all the blocks are generated, and in the cue list, Add the pieces to the play list by selecting the 
wave portion in the cue list and clicking Add in the play list. Select the pieces listed below in the order
given.    After doing so, select each item in the play list, and change the Loops for each so the final 
play list looks like this:

(1) 10 to 8Hz
(3) 8Hz
(1)      8 to 6Hz
(7) 6Hz
(1)      6 to 5Hz
(18)    5Hz
(1)      5-8-5
(12)    5Hz
(1)      5-8-5
(12)    5Hz
(1)      5-8-5
(12)    5Hz
(1)      5-8-5
(12)    5Hz
(1)      5 to 12Hz

When you choose -Play- from the play list, the sequence will be played in the order given, looping the
number of times specified.    This list gives a 21 minute theta session, with bursts into alpha at four 
points.

11 If you wish to save this piece, and have enough hard drive space, you can do it now.    The wave is 
complete.    Enjoy.



About Brainwave Files
The wave option works like many meditation tapes and light/sound devices on the market, which range in 
price from $200 to $500.    There's even a board available with plug in glasses (which have blinking lights) 
for your PC for $495.    I think the files created using the 'Wave' transformation are even more powerful, 
and are definitely more pleasing to the ears.    Most other devices and tapes have a "humming" sound or 
some other tones to induce the right brainwave frequencies.    This program allows you to use ANY sound 
to encode the frequencies with.    The most effective I have found are by using the noise generator, which 
creates pleasing waterfall like sounds.    This function only works on stereo waveforms, and the effects 
work if only if listened to with stereo headphones.

 There are four major (perhaps more) Brainwave Patterns ranging from deep sleep to acute awareness.    
Listening to sounds that have been waved for periods of 5 minutes or more will produce the desired state 
of awareness in the listener.    Sessions of 25 minutes or so work really well!

Many Uses

About Carrier Waves
Encoding Brainwave Information
Authoring Brainwave Files
Step-By-Step Theta File
How to Use Brainwave Synchronization Files

Articles on Theta meditation
References

DISCLAIMER
By using this program, you agree that the author of the program will not be responsible for any damage as a result, 
direct or indirect, of using this program.

WARNING
Sounds generated by the wave function are not suitable for epileptics or persons undergoing psychiatric treatment 
since it does alter ones state of consciousness.
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Many Uses / Effects of Using
Immediate Relaxation and Stress Relief
Choose between 5hz and 10 hz for different levels of relaxation.
Meditation
Choose between 4hz and 7hz, either cycle between a few, or stay at a particular frequency for different 
results.
Improved Sleeping Patterns
Any of the Alpha and Theta frequencies (8Hz to 4Hz) for 30-45 minute sessions.
Treatment of Insomnia
Choose between 4hz and 6hz for starters (1/2 hour), then go into frequencies below 3.5hz (1/2 hour), 
settling on about 1.5hz to 2.5hz for sleep.
Improved and Lasting Sense of Well Being
Try Theta (4Hz to 7Hz) for 45 minutes, daily.
Creative Visualization
About 6hz for a while, then up to 10hz works well.
Alleviation of Migraines and Headaches
Experiment with Alpha and Theta combinations.
Reduction of Depression Symptoms
Again, Alpha and Theta combinations, mostly theta(?)
Self Hypnosis
Choose about 8hz to 10hz while playing any self-hypnosis tape, or guided meditation.
Super Learning
Choose about 7hz to 9hz while playing any learning tapes, like foreign language tapes, etc. to increase 
comprehension.
Subliminal Programming
Choose 5hz to 7hz while playing your favorite subliminal tapes, or make your own by recording some 
affirmations, and mix paste them from the clipboard at barely audible volumes.
Improve ESP / Intuition
Theta frequencies help in this area, 4hz to 7hz.
Reaching Higher States of Consciousness
Theta again, with daily half hour sessions.
Quick Refresher on long days
Low Alpha 8hz to 10hz for about 15 minutes works well.
Increased Immune System
Relaxing to Alpha and Theta combinations daily.

Using Alpha Synchronization (8Hz to 12Hz), expect similar increases in neuro-chemical levels:
11% increase in Norepinephrin levels
21% increase in Serotonin levels
25% increase in Beta-Endorphin levels



How To Use
Once you have created your brainwave file (15 minute files on up work best), loop play them for a longer 
listening time.    Sessions of 15 minutes or more work best.    It is best to listen to the sessions lying down 
in a quiet place where you will not be disturbed.    If there is no place like this near your PC, it may be a 
good idea to record the session on tape and listen to it where you can be comfortable and relaxed.    
When you're fully comfortable, start the session, close your eyes, and let the magical sounds from Cool 
Edit do the work.    Remember, this only works if you listen to the    sounds with stereo headphones.

You may notice helicopter, or "washing" type noises moving around in your head.    These sounds are 
actually created inside your head, and are not coming directly out of either channel from the sound board. 
It is this noise that is doing the work of helping your brainwaves get synchronized to the patterns you have
chosen.    When I have mixed two different (but similar in frequency ranges) brainwave files together, I 
have noticed a jet airplane noise moving slowly from left to right in the background.    Some people don't 
hear these artifacts at all, while others hear them extremely well.

Another side effect is that of a wandering mind.    When I use frequencies under 8hz, I find myself thinking
of the strangest things.    You may find that you are not thinking of anything in particular, and your thoughts
become very interesting.    The feeling is also "warm" and "happy" for some people.    Others start recalling
their favorite memories as a child, even some they thought they had forgotten forever!

After a session of 15 minutes or more, you may feel quite refreshed, light, airy, clear-headed, etc.    I 
always find myself feeling very good afterwards.    Some claim that doing this for 30 minutes a day can 
result in subtle but great changes in your life.    ESP experiences increase, and you may be able to reach 
new levels of awareness in your everyday life.



Unsolicited Testimonials
Excerpts from Articles on Theta Meditation

Any results gained from using Light/Sound devices such as the Voyager, the Brain Machine, MasterMind, 
the MindsEye, etc. can be gained from listening to these files as well.    Some of these excerpts are from 
results using these machines with flickering light goggles and tones.

This is my own testimonial.    I find that within minutes of listening to a Theta pattern, my thoughts start 
drifting to really weird stuff that doesn't make any sense at all.    It is really quite funny some of the things I 
find myself thinking of.    Then I start to feel really "good" and relaxed--at peace if you will.

It has been stated in several places that a half hour a day of the brain being in the theta state can replace 
up to 4 hours of sleep.    People find they need less sleep at night.

Thirty patients had sessions in Theta (5 hz) and experienced relaxation states of 80-100% after five 
minutes as well as improved pain relief.    Eight patients had blood tests before and after the sessions and
showed improved beta-endorphin levels of 10-50%.

Using a first-generation prototype light/sound device, one doctor noted, "these devices produce a distinct 
relaxation state.    Programming the device between 3 and 7 hz, it takes about 10 to 15 minutes for the 
patients to enter--effortlessly--a state of hypnosis.    They terminate the sessions relaxed and with a 
feeling of well-being."    Also, "the device has a calming effect on the nervous or anxious patients.    In a 
majority of cases, the patients feel relaxed, and calm during a period of three to four days after the 
session.    It happens that the subjects have a reminiscence of childhood experiences, particularly when in
Theta.    They related their experineces which we incorporated into our psychotherapeutic program."

"The machine works like a tranquilizer and the effect lasts for several days.    Using the machines in Theta
frequency, clients are very receptive to suggestions on behavioral aspects such as reducing tobacco, 
alcohol and food consumptions."    Many patients "were more creative during the sessions."

"By inducing hemispheric coherence the machine can contribute to improved intellectual functioning of 
the brain.    Like children spending most of their time in Theta, the machine allows a reduction in learning 
time.    With adults a return into Theta allows them to rediscover childhood experiences.    The machine is 
like a 'lost and found office' for the subconscious."

D.J. Anderson, B.Sc., M.B., "The treatment of Migraine with Variable Frequency Photo-Stimulation," in 
HEADACHE, March 1989, pp 154-155:

 D.J. Anderson used photo-stimulating goggles with variable frequency using    red LEDs in order 
to stimulate the optic nerve, through closed eyes, right    and left with frequencies between 0.5 
and 50 hz.    The study included    seven patients who suffered a total of more than 50 migraines 
during the    observation period.    Forty-nine of these migraines were relieved (either    by reducing
the average duration or by increasing the frequency interval    in between migraine crisis) and 36 
other migraines could be stopped while    using the goggles.

The more these sounds are used, the easier it becomes to produce and maintain Alpha/Theta rhythms.    
As these states of higher awareness become infused into normal brain activity, the result can lead to what
some have called a fifth state of consciousness, or an "awakened mind."    In this state of illumination and 
bliss one sees the world as distinctly as before but with a new mind that perceives the universe with new 
meaning.    It's this experience of illumination that is the seed for all breakthrough scientific theories, 
literary ideas, revolutionary inventions, and artistic masterpieces.    The technology used here induces 
these states by forcing your brain to focus your mental energies inward... tapping your own vast reserve 
of creative genius and eventually unfolding "an enlightened state of awareness."

An unusual side benefit of listening to these sounds is a surprising need for less sleep.    Some users are 
able to reduce their sleep requirement by as much as 3 - 4 hours each night, rising each morning feeling 



refreshed as if they had slept a full 8 hours.    The reason?    It's believed the theta-sounds replace the 
need for extensive dreaming which is the main purpose of sleep.    Another interesting side effect, many 
users report a dramatic increase in sex drive.    No one knows exactly why, but it may be linked to 
changes in brain chemistry.    But, perhaps the most unusual side effect is the reported increase in psychic
functioning, including episodes of precognition, out-of-body experiences, and spontaneous channeling 
events.

When you finish each session your entire body becomes charged with a new energy and vitality.    Fears 
and anxieties are gone.    You are renewed, more alert, and mentally you feel on top of the world.

What causes the euphoria and peak experiences?    The neuroscientists say the 'high' you experience is 
caused by a release of endorphins in the brain.    A hundred times more powerful than morphine it makes 
you feel like you're soaring with eagles.

Zen meditators have been found to alter Alpha/Theta frequency according to their depth of meditation, 
reports Japan's leading neurophysiologist, Dr. Tomio Hirai.    he has correlated brain-wave patterns with 
certain stages of meditation.    And according to Dr. Hirai, "Meditation is not merely a state between 
mental stability and sleep, but a condition in which the mind operates at the optimum.    In this condition 
the person is relaxed but ready to accept and respond positively to any stimulus that may reach him."

Research now confirms that brainwave rhythms correspond to certain states of consciousness, and this 
suggests that individuals capable of altering their brainwave patterns can have significant control over 
other mental and physiological functioning.    As Elmer and Alyce Green of the famous Menninger Institute
first reported in the mid-70's, "...simply causing your brain to generate theta activity for a few meinutes 
each day seems to have enormous benefits, including boosting the immune system, enhancing creativity, 
and triggering integrative experiences leading to feelings of psychological well-being."

Biofeedback researchers have found that people who enter the "theta state," expand their states of 
consciousness, acquire super-receptivity to new information, and demonstrate a greater ability to 
"rescript" material on a subconscious level.    Even more astonishing are the findings of a study conducted
on a group of chronic alcoholics at a University in Colorado.    After 13 weeks the group that learned to 
generate theta and alpha brainwaves, showed a far greater recover rate, and a complete transformation 
of personality. There is a remarkable body of evidence...

Another Note:    I did not do alot of proper citing, I just wanted to present some information that is available
"out there".



The major brainwave patterns are:
Beta > 13 hz Normal state of alertness, stress and anxiety.
Alpha 8-12 hz Light relaxation, "superlearning", positive thinking.
Theta 4-7 hz Deep relaxation, meditation, increased memory and focus.
Delta 1-3 hz Deep sleep, lucid dreaming, increased immune functions.
Gamma200+ hzNot sure exactly what these do...



Selecting Loop/Play Toggle from the Options menu will toggle the play button between the Loop and 
Play states.



Selecting Monitor source from the Options menu will start monitoring the recording source, which is 
useful for setting the recording levels before recording.    To stop monitoring, press the Stop console 
button.



Use the mouse to click on the starting point of the wave you wish to select, then drag the mouse to the 
ending point.    When doing this, the portion that is being selected will be inverted (you'll see a white bar 
indicating the selected portion).    Use the Shift button in combination with the mouse to extend a 
selection.

Double-clicking in the viewing field will select the entire viewing field.



After selecting a range, Zoom In will expand the selection to full viewing area



If zoomed in, zooming out will display more of the wave in the viewing area to the left and to the right.



Clicking on Full View will display the entire waveform in the viewing field.



The green bar above the viewing field will shrink or grow depending on whether the view is zoomed in or 
not.    The location of the green bar depicts the relative location in the waveform the viewing area is 
displaying.    Clicking on the green bar and dragging left or right will scroll the wave being viewed left or 
right.    Double-clicking will bring up the samples data entry box.



Beginning and Ending samples are displayed in the boxes at the right side of the window.    Beneath is a 
time display showing the amount of time selected, or currently being viewed.    Double clicking on any of 
these displays will toggle the mode between Samples and Time.



Clicking the Play button will play the selected range, or the entire portion of the wave in the viewing field if
no range is selected.    If the button reads Loop, then the selection will be repeated until the Stop button 
is pressed.



Clicking the Stop button will stop the currently playing wave from playing.



If your system supports recording, pressing this will start recording.    Press Stop when done recording.    
Recording starts at the insertion point and overwrites any data thereafter if any.



The point of insertion for Paste and Paste Special is indicated by the yellow arrows above and below the 
viewing area.    The exact sample is listed in the Beg: box.



Technical Notes;Temporary Drives;Default Wave Directory
Note 1:
When a file is opened using COOL, a temporary file (~COL????.TMP) in your temporary directory is 
created.    This is where the actual wave data is going to be played from, recorded to, or edited.    This 
means that the largest file that COOL will work with is limited to the amount of free space on the hard 
drive containing the temporary directory (pointed to by the TEMP environment variable).    If you wish to 
save the file, you must have enough free space on the drive you are saving to.    Remember that the 
temporary file for COOL is taking up space on the TEMP drive, which means you cannot save a file onto 
your TEMP drive that is larger than one half the amount of free space you had on your TEMP drive before
you started.    If COOL crashes, there may be a temp file (~COL????.TMP) in your temporary directory 
that you should delete.

One advantage to using this method is virtually unlimited waveform sizes, since it depends only on the 
size of your hard drive.    If you have a 500 meg hard drive, you can record one hour of CD quality music.   
The drawback, of course, is that the temporary file can get extremely large, which may not allow you to 
save your masterpiece on the same drive.    Of course, if you have a second hard drive with enough 
space, there will be no problem saving the wave.

Note 2:
If you are using a compressed, or double-spaced hard drive, there are some special considerations.    
Recording high data rate waves (such as 44.1K/Stereo/16-bit) may severely slow down your system.    If 
your system appears to lock up, press the Stop button, then try reducing the play/record buffer size in the 
Settings menu.    Also be aware that the initial recording time left that is displayed when recording can be 
slightly off, since the amount of space audio data takes up on a compressed drive varies with the type of 
audio being recorded!    Cool will try and estimate the time left every few seconds, so if you see a jump in 
time left (either a favorable jump, or a not so favorable decrease) it is because Cool is trying the best it 
can to estimate the remaining time.

Note 3:
For fine tuning your system to take full advantage of both your sound card, and the COOL program, 
please see the Settings section.

If you wish to have COOL use a separate directory for the temporary file (other than that pointed to by the 
TEMP environment string), then add the line "TempOverride = E:\newdrive" to the [Size] section in 
cool.ini, where E:\newdrive can be any drive, and any directory you want to use for temporary files.

Note 4:
For more accuracy in using any transformation, use 16-bit samples while working with waves.    If your 
board only supports 8-bit samples, you can have them converted on the fly at playback time by choosing 
the "convert 16 to 8 bit" mode in Settings.    To convert an 8-bit sample to 16-bit, open the waveform, copy
the entire wave, then say "New" and choose 16-bit, and paste the waveform.    Alternatively, you can open
an 8-bit file as 16-bit by using File:Open As, or    you can use the Edit->Convert Sample Type option.

Note 5:
All temporary files begin with the tilde (~) symbol.    The main Cool Edit temporary file containing the 
currently active waveform begins with ~COL.    Undo information is saved in a file starting with ~NDO.    
Some other functions create files starting with ~CTE and ~CTM.    All temporary files have the .TMP 
filename extension.    The rest of the filename is chosen at random when the file is created.    If there are 
no copies of Cool Edit running, none of these files should be present.    If you find them, you can safely 
delete them, as long as Cool Edit is not running.    These files can be left behind in extreme circumstances
when Cool Edit crashes, or Windows unexpectadely quits while Cool Edit is running.

Note 6:
Cool Edit uses the Windows convention of defaulting to the directory specified in the program manager's 



Properties for the program's icon.    This is actually a very good method, as you can make several icons 
and have each point to a separate default working directory.    To have Cool Edit remember the last 
directory you were in would violate this convention.



Known Bugs
When "NT Compatibility" is not checked in the Options:Settings dialog, Cool Edit can freeze up if multiple 
copies are open, and two or more copies are updating their waveform display area at the same time.    
This does not happen if you are only working on a single copy at a time, but can happen if, for example, 
one copy of Cool Edit just finishes a calculation and is updating its waveform display, and another copy 
just finishes loading a new waveform and is now displaying its waveform data at the same time.    Again, if
you are working simultaneously on many instances of the program, where more than one copy is in the 
process of calculating and/or loading at the same time, uncheck the "NT Compatibility" box in 
Options:Settings.    This will force Cool Edit to redraw the entire waveform before allowing other processes
to run.    Doing this will also disallow the ability to play a waveform before it is finished being displayed.

In a related bug, do not re-size Cool Edit while it is in the middle of updating the screen after a re-sizing 
(this is impossible to do if NT Compatibility is turned on).    Currently, this may cause a lockup as well.    I 
am working on revising the display code to resolve these problems.

If you find you cannot load or save .WAV format waveforms, if you try to load a .WAV waveform file and 
the "Choose Sample Rate" dialog appears, or have any trouble with loading and saving in the proper 
format, then remove all copies of the .FLT files on your hard drive, and copy over the ones distributed with
your current version of Cool Edit into the same directory as COOL.EXE.    If different versions (older or 
newer) of the .FLT files are mixed with the distributed versions, these problems could arise.    This 
problem could also result from running a separate program with the same name as the .FLT file (eg 
wave.flt will not be used if an application called wave.exe is running).    If this is the case, simply rename 
the .flt file (eg rename wave.flt to wav.flt).

If the TEMP environment variable points to an invalid directory, some functions may fail.    Be sure the 
TEMP environment variable is set to a valid directory with plenty (at least 1 meg) of hard drive space.    
Alternatively, you can add the TEMPOVERRIDE= line to the [Size] section of cool.ini (found in the 
Windows directory) and set it to your temporary drive and directory.






